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CHAPTER 1: GETTING STARTED

What Equipment Will You Need?

Before you can start working with WinSong's programs, you will need to have the following 
hardware and software:

Required Equipment

An IBM or IBM compatible computer (capable    of    running Microsoft Windows) 

Hard Disk

Microsoft Windows, (Version 3.0 or higher)

A mouse

Optional Equipment

If you are planning to print your compositions, you will need Windows 3.1 and a graphics printer.

If you are planning to listen to your scores or use WinSong's TapeDeck and JukeBox applications, 
you will need a MIDI interface card (Roland MPU401, Soundblaster or compatibles, or any other MIDI 
card    with a Windows    3.1 MultiMedia driver).



Installation

If you have not already installed WinSong on your hard disk, it is easy to do.    Just follow these 
instructions. 

First, make a backup of your distribution diskettes and put the originals in a safe place.    Now you 
can use the backup diskettes to install WinSong.

The INSTALL.EXE program will walk you through the proper installation procedures.    Just be 
sure Windows is running when you are ready to begin installation.    Then:

Insert the INSTALL disk into an available drive.

Pull down the File menu in the Program Manager.

Select the Run option.

Type: A:INSTALL.EXE at the command line. (A: identifies the drive in which you've placed the 
Install diskette.)

The Install program will now transfer all of the files from the distribution diskette into the WinSong 
sub directory on your hard disk.    It will prompt you if you need to change diskettes and ask you certain 
questions about your hardware and other preferences.    Answer them the best you can.    If you don't 
know the answer, then just accept the default answers.

The Install program will create several icons on the screen for you.    One of them is the 
README.TXT file.    Be sure to read this file for the latest information about the release of WinSong that 
you have.    There might be answers to questions you have that did not get into this manual.



CHAPTER 2: WINSONG COMPOSER

Welcome to WinSong Composer!    Composer will change the way you approach musical 
composition--you now have the same freedom that computerized word processing programs have given 
to writers. You can create, edit and play your own songs with an ease never before possible.    Composer 
also allows you to hear how your compositions will sound before you even print out the score. 

If your computer is equipped with a MIDI card and you have a MIDI keyboard, Composer allows 
you to type in musical symbols and control your computer with your MIDI keyboard.    You may also enter 
music with a mouse.    Composer will also read Standard MIDI files and files generated by the TapeDeck 
so you can write out what you play automatically.

Because Composer works within the Microsoft Windows graphical interface, the program is 
organized in a manner that makes it easy for anyone to use, whether you are a computer expert or just a 
beginner.    This chapter provides instructions to help you get started, and offers a handy reference guide 
to answer any questions you may have.



Getting Started

To get into Composer, simply double click on the Composer icon which appears in the main 
Windows Menu Screen.    Click on the OK box which will appear with the first screen, and you are in 
business!    This is the screen that you will see.    Take some time to familiarize yourself with the different 
areas on the screen.



Basic concepts you should know:

The Palette

In addition to your pull-down menus, Composer is equipped with a dual-line palette containing 
symbols used in musical notation and buttons for controlling the Composer. This palette, which consists of 
two "ribbons", can be edited and adjusted to meet the individual composer's needs, using the Options 
pull-down menu.    Use the arrows located to the right of the top ribbon to scroll through the different 
symbols.

Placing Symbols on a Staff

The main screen includes an empty staff for you to compose on.    This staff is as long as your 
composition.    As you add symbols, the screen will automatically scroll to the right.    You can add more 
staves when you need them.    You can only place symbols on the white part of the screen.

The current staff is always blue.    If you do any operation in the Composer, it will only affect the 
current staff.    In order to switch staves, click on the staff you want to work on with the right mouse button.

To place a symbol on the staff, highlight the symbol on the top line of the palette you want to 
place on the screen by clicking on it with the left mouse button.    Then go to the position on the staff 
where you want to place that symbol and click on it with the left mouse button. 

For more information on the mouse buttons, see About Those Mouse Buttons...

Grids
There is a red dotted line that goes from the top of the screen to the bottom of the screen.    This 

is a grid mark.    If you put a whole note in a measure, there is only one grid mark.    If you put a half note 
in a measure, there will be 2, if you put a quarter note there will be four.    It is important that you line notes 
up on the correct grid marks or they might sound wrong when you play them back.    All notes up to a 
sixteenth note have red gird marks.    Thirty-second notes, triplets, quintuplets and septuplets have green 
grid marks.    If you want to adjust the position of a grid mark, you can drag the grid by holding down the 
shift key and clicking and dragging with the right mouse button.

Blinking Cursor

The blinking cursor in WinSong is similar to a cursor in a word processor.    Whenever you type in 
a note on the MIDI keyboard, it is always placed at the grid mark where the blinking cursor is.    You can 
place a note with the mouse anywhere.    After placing a note, the blinking cursor will move to the grid 
mark where the next note should be placed.    You can also move the cursor left and right with the arrow 
keys.    If you hit the backspace key, the bottom note at the current cursor position will be deleted and the 
cursor will move to the nearest note to the left if there are no more notes at the current position.    If you 
want to reposition the cursor with the mouse, you can click with the right mouse button and the cursor will 
move to the nearest grid mark.

For more information on placing symbols with the MIDI keyboard, see Using Your MIDI Keyboard.



Main Menu Options

WinSong's Composer is arranged 
so that you should not need much help to 
get in and start creating music.    The pull-
down menus include the following:

* File
* Edit
* Staff
* Goto
* Controls
* Options
* Help

Some of these choices in the menus are duplicated by symbols on the second row of the palette. 
Cut, Copy, Paste, Play, MIDI keyboard on - off, Metronome toggle, Goto and Beam all have buttons on 
the screen.



File Menu

The File menu allows you to:

* Open a file
* Begin a New file
* Save a file to disk
* Save a pre-existing file under a new name
* Exit the program
* Print
* Set up Printer
* Customize Page Layout

Open
To open a file, simply select the Open option.    A dialog box will ask you the name and type of file 

you wish to load.    You may load either Composer files, TapeDeck files or Standard MIDI Files.

New
To create a new file, select the New option from the File menu.    An empty staff will appear on 

your screen.

Save
To save a file, select the save option.    If the file is a new one, you will need to name it before it 

can be saved.    If you loaded a Standard MIDI file, the file will be saved as a Type 1 Standard MIDI file.    
It is recommended that you save your work in Composer files because a Composer score has much more 
information in it than a Standard MIDI file was designed to keep.    Beaming, staff settings and other 
formatting information will not be saved in Standard MIDI files.

Save As
To save an existing file that you have modified under a new name, use the Save As option.    This 

function is nearly identical to the Save command,    except that a dialog box pops up asking you for the file 
name and the type of file you want to save it as.    You may save files as either Composer files or 
Standard MIDI Type 1 files. 

It is recommended that you save your work in Composer files and only use Standard MIDI files as 
an export mechanism because a Composer score has much more information in it than a Standard MIDI 
file was designed to keep.    Beaming, staff settings and other formatting information will not be saved in 
Standard MIDI files.    Any staves that were muted will be saved with a zero master volume midi event at 
the beginning.    Some synthesizers may not respond to master volume events and you will hear the 
tracks anyway. 

Print
The Print option allows you to print your current score.    When you select this option, a dialog box 

will appear allowing you to choose options for printing.    When you press the OK button your score will be 
printed.    See PrintingYour Scores for more information.

Print Setup
The print setup option will launch the Print Settings dialog box for the default printer you have 

installed in Windows.    It allows you to choose such things as page size, landscape or portrait pages 
depending on the printer driver you have installed in Windows.

Page Layout
This option allows you to set the margins of the page, put titles on the page and select other 

formatting settings.    See Printing Your Score for more details.

Exit



Exiting Composer is easy--all you have to do is select the Exit option from the File menu.    If you 
have not saved your work, you will be asked if you want to.



Edit Menu

The pull-down Edit menu has some very useful options.    You can use this menu to:

· Cut
· Copy
· Paste
· Beam

To delete a section from your composition, select the Cut option from the Edit Menu or the Cut Button 
pictured above.    This dialog box will appear:

When you have set the beginning and ending time of the cut, simply click on OK.    If you decide that 
you do not wish to make any changes, just hit Cancel, and this will take you back to the main dialog 
screen.    You may also mark an area with the mouse by using the Mark feature and cutting the marked 
area.

To copy a section of the staff, select the Copy option from the Edit menu or press the Copy button 
pictured above.    This works in a manner similar to the Cut option; a small dialog box will appear, asking 
you to designate the area to be copied.    When you have made your choices, select OK.    You may also 
mark an area and copy it.

The Paste menu option and the Paste Button pictured above allow you to insert a copied section 
of music into a new location on the staff.    (This can also be used to paste in items from WinSong 
TapeDeck or another copy of the Composer).    A dialog box will appear asking you to designate the new 
location, whether or not you wish to transpose, the number of copies to paste and whether you wish to 



paste repeats on measures. Once again, when you have made your choices, just click OK.

When you select the Beam option from the pull-down Edit menu or the Beam button pictured 
above, you can beam notes together.    You can either mark an area to be beamed, (see Section below, 
on Marking an Area), or do this globally by hitting the beam button when no area has been marked.    In 
this case, a dialog box will appear asking you "From where/To Where" so that you can specify where you 
would like the notes beamed.



Staff Menu

Your staff menu offers you a number of choices concerning the staff itself.    Use this menu to:

· Add a new staff
· Delete a staff
· Specify staff settings
· Insert or delete measures
· Delete Unused Grid marks

To add a new staff to your working screen, all you have to do is select Add New Staff from the 
Staff menu.    A new staff will appear below any staves that are already in your score.    If you wish to 
delete the currently highlighted staff, simply select Delete Staff from the Staff menu.    You may have up to 
64 staves at one time.

Inserting and deleting measures is also simple.    When you select Insert Measure, a dialog box 
will ask you "Insert after measure"... and "Number of Measures to Insert".    When you have made your 
choices, click on OK.    The Delete Measure option functions in a very similar manner; a dialog box will 
ask you "Delete from Measure"...and "Number of Measures to Delete."    Once again, clicking on OK will 
activate your selections.

To specify your initial staff settings, select the Staff Settings option from the Staff menu.    This 
dialog box will appear:

You can select a title for your staff at this point, and specify a volume level by using the arrows in 
the dialog box.    The events on a staff can be forced to a particular MIDI channel.    Channel 0 means that 
the events on a staff will not be forced.    You may also choose a transposition setting for the staff.    This 
only affects the pitch of notes when they are being played.    This is useful when writing for transposed 



instruments such as a clarinet. The initial key on the staff can be selected as well as the first clef on the 
staff.    Mute will silence the staff when you play your score.    You may beam the current staff to the next 
staff and you have the choice of adding a bracket or a brace at the left of the staff when printing.    If you 
want a bracket or brace that covers more than one staff, make sure that the beam to next staff setting is 
on and that the next staff also has the brace or bracket setting turned on.

 Once you have selected the settings you want, just click OK.



Goto Menu

Your Goto Menu is very straight forward.    Here are the options that will appear when you pull this 
menu down:

· Goto Measure
· 1st Marker
· 2nd marker
· 3rd marker
· 4th Marker
· 5th Marker
· Set 1st Marker
· Set 2nd Marker
· Set 3rd Marker
· Set 4th Marker
· Set 5th Marker

Use this menu to move to selected measures and markers within your composition.    Use the 
Goto option to jump to a measure which is not preset.    Use the marker options to jump to measures 
which have been preset, and use the Set Marker options to pre-set markers.



Controls Menu

The Controls menu has the following options:

· Play
· Stop
· Metronome
· Tempo
· Scroll While Playing
· Midi Keyboard
· Midi Thru
· Internal Sync

Selecting play allows you to hear your score.    It has the same effect as pressing the play button 
on the palette pictured above.    Play will begin at the beginning of the first measure on the screen.    Stop 
will stop your score from playing further and is the same as pressing the play button on the palette when 
your score is playing.

The Metronome option toggles the metronome on or off and is the same as pressing the 
metronome button on the palette pictured above.

When you select the Tempo option from the Controls menu, a small dialog box will appear that 
looks like this:

This setting only changes the current tempo of your song while you are playing it.    It has no 
permanent affect on the score.    Use the small arrows to scroll through and set the Tempo as high or as 
low as you wish.    To enter tempos into a score, use the button on your palette which looks like this: 



This dialog will appear:

A tempo mark will be inserted above every staff in your score and the tempo of the piece will 
change when that point of the score is reached during playback.

If you would like the screen to scroll while playing your song, click on the Scroll While Playing 
option.    This just means that the screen will move along, or scroll, as your song plays.

The MIDI keyboard option is a toggle key that allows you to turn your keyboard option on and off. 
It is the same as pressing the keyboard button on the palette pictured above.    The keyboard option, 
which allows you to enter commands by typing them directly from your MIDI keyboard, is discussed in 
greater detail later in this Chapter. 

The MIDI Thru option is another toggle function, which lets you choose whether or not you wish to 
echo incoming MIDI data out through the MIDI out port attached to your computer.    It is the same as 
using the MIDI Thru button on the palette pictured above.

Finally, the Internal Sync option tells Composer to keeps its own internal clock while playing.    If 
this option is turned off, it tells Composer to wait for an external MIDI clock and before playing and to sync 
up with the external clock.    If you are using the WinSong MPU-401 MIDI driver you can also sync to a 
tape if your card supports sync to tape.



Options Menu

The options menu allows you choose from the variety of options that are available to you in 
Composer. This is also where you can customize the Composer Palette to your own specifications.    Here 
are the options you will see when you access the pull-down menu:

Show Grid
Edit Palette
Ribbon 1
Ribbon 2
Ribbon 3
Ribbon 4
Ribbon 5
Mouse Channel
MIDI Mapper

Below is a brief discussion of each of these features:

Show Grid

Show Grid is a toggle function, for composers who find a Grid helpful.    It has the same effect as 
using the Grid button on the palette pictured above.    If you check this function, the Grid will appear, and if 
you do not check it, the Grid will be hidden.

To understand how the Grid system works, imagine that you have just placed a measure on the 
staff.    When you activate your Show Grid function, you will see just one Grid mark.    If you should place a 
whole note in this measure, the Grid will still show just one mark and a new measure will be created.    
However, if you add a half note, you will now see two Grid marks in the measure.    After placing a quarter 
note, you will see four Grid marks, after placing an eighth note, you will see eight Grid lines, and so on.    
Grid marks for notes up to 16th notes will appear red, but Grid marks for notes of higher values, for 
example, 32nd notes, will appear green.

The Composer will play the notes in a score differently depending on the grid mark they are on.    
If you were to place a half note on the second grid of a measure that has four grid marks in it, it will play 
on the second beat of the measure even if there are no notes or rests on the first beat. 

Edit Palette

This is one of Composer's most helpful options!    Edit Palette allows you to customize the palette 
you are working with, by selecting different ribbons and musical symbols for your main dialog screen.    
When you choose this option, this dialog box will appear:



Layers 1 through 5 show the notation symbols which are available to you on each ribbon of the 
palette.    The palette scroll bar allows you to scroll through the available symbols, and select those that 
you wish to use.    To change which symbols are on a layer of the palette, click on the symbol you want on 
the palette and drag it to the position on the layer where you want it.    With this feature you can have the 
symbols most useful to you during a particular stage in your composition process available on the screen.

Ribbons 1...5

When you click on any of these ribbons, the palette on the main dialog screen changes to the 
ribbon you have selected.    You can also scroll through the palette layers by using the little arrow buttons 
on the screen pictured below.

Mouse Channel

This feature allows you to decide what MIDI channel any events you insert with the mouse are 
on.    Once you have set the channel, any events that you put in your score will be on that MIDI channel.

MIDI Mapper

This option allows you to launch the Windows MIDI Mapper, if you are using the MultiMedia MIDI 
Driver and are in Windows 3.1.    For further information on MIDI Mapper, refer to your Windows Manual.



Help Menu

This menu is included to answer your questions when you are working with Composer.    The Help 
menu includes the following options:

Index
Using Help
About Composer 3.0
Softronics

Index will take you to the main help screen.    Using help will take you to the help system for 
Windows Help.    About Composer 3.0 will bring up information about the your copy of the program, 
including its serial number and revision number.    You will need this information when calling for technical 
support.    Softronics will give you information about other Softronics products.



What Else Do You Need to Know?

Using your Midi Keyboard with Composer
Printing Your Scores About those Mouse Buttons
List of Composer Symbols



Using Your MIDI Keyboard with Composer...

You will need to know a few things about the way that WinSong's Composer allows you to work 
with your keyboard.    One of the most exciting aspects of this program is that you can use your keyboard 
to send symbols to your computer screen.    To do so, click on the Keyboard Button located on the second 
palette ribbon.    This activates the Keyboard function.    Then, simply play the notes that you wish to send 
to the on-screen staff, and watch as they appear!

A keyboard template also lets you use your keyboard instead of the computer key pad to enter 
commands.    To activate this function, turn the pitch bend wheel on your keyboard, or depress the sustain 
pedal.    This saves you from having to switch back and forth from your computer key pad to your 
keyboard when you want to enter computer commands.

MIDI Keyboard Template

Your MIDI Keyboard Template offers you the option of using your keyboard to enter commands 
and place notes on the staff.    The Whole Rest symbol fits over the middle C key on your keyboard.    The 
Template offers you a variety of symbols, and a Delete key, which functions like the backspace key in 
many word processing programs, allowing you to delete notes. 

When the MIDI Keyboard setting in Composer is turned on, you can enter symbols with your MIDI 
keyboard.    If you have the Whole note symbol highlighted, you can play a chord on your MIDI keyboard 
and the notes will appear on the screen at the grid mark where the blinking cursor is.    The blinking cursor 
will then move to the next place where notes should go.

If you hold down the sustain pedal on your MIDI keyboard, you can then hit a key that 
corresponds with a symbol on the palette, and that symbols will be highlighted on the palette.    Then 
when you let off of your sustain pedal, your MIDI keyboard will begin inserting the highlighted symbol on 
the screen again.    If while holding down the sustain pedal you use the Delete key on your MIDI 
keyboard, the bottom symbol at the current blinking cursor position will be deleted and the cursor will 
move to the grid that has the nearest previous note.

If you don't have a sustain pedal you can use the pitch bend wheel in its place.    When the pitch 
wheel is set anywhere other than 0, the template will be active.    If it is at 0, then the MIDI keyboard will 
be placing symbols.



Printing Your Scores

The Composer can produce very high quality printouts of your music in a variety of different ways. 
You can print enlarged scores for easier reading, you can print miniature scores for conducting, you can 
print the pages so that you can tape them together to make a much bigger page than your printer 
normally allows and you can automatically extract parts from a score and print them individually.    First 
you will want to set up your page layout, then you will want to print your composition.

Page Layout
The Page Layout option under the file is where you can fine tune the "look" of your composition, 

by entering    titles,    page numbers, copyright notices, etc.    When you select this option, this dialog box 
will appear:

Here are the push-button features available under the Page Layout option: 

· Title Page
· Left Page
· Right Page
· Page Size
· Start Left/Right
· Margins

Title Page brings you to the Title Page of your composition, while Left Page and Right Page allow 
you to edit, respectively, the layout of all the left and right pages of your composition.

Page size lets you specify the size of the paper you wish to print your composition to.    For 
example, if you need to print a very large score, this option allows you to do so.    This option does not 



affect the page size that your printer produces.    Instead it automatically lays the page size that you want 
to print out across several pages on your printer if it won't fit on a the page that the printer is currently set 
for.    It automatically sends the blown up pages to the printer in sections (down and then across). When 
all have been printed, you can put them together like a finished puzzle--creating a score much larger than 
any that your printer is capable of printing all at once.    Normally you will want to match this page size to 
the size of the page your printer is set for.

Start Left/Right allows you to choose which side to start the title page on, while Margins lets you 
set the margins for your composition.    The margins are for each page--your title page has a set of 
margins, and the right and left pages each have their own set.    You must specify these individually for 
all three page types.

If you click on the Page button on the imaginary page on the screen, you will see this smaller 
dialog box appear:

You can enter in any text you want to have displayed along with your page number.    Enter ## 
where you want the page number to go.    Example:    Entering "This is Page Number ##" on the Title Page 
will print "This is Page Number 1" on the first page.    (Page numbers can be placed in this manner in any 
area within the Page Layout screen, and the appropriate page numbers will appear in that location.)

The printed page will be affected by the settings you have chosen in the Page Layout menu 
option.    If you do not include any text in the Page Layout boxes, the corresponding empty space will be 
used for notes.

Printing
To print your work, choose the Print option from the file menu and set the options in the dialog 

box that appears.    You have a number of choices available.    You can start printing at any page in your 
score and stop printing at any page in your score.    You change the number of the first page of your score 
and all of the pages thereafter.    This is useful when you have broken your score up into more than one 
file.    If you start the page numbers at five instead of one,    the first page of your score will have the 
number five on it.    The fourth page of your scare will have nine for a page number etc.

You can turn off your headers and footers before printing, or print measure and patch numbers 
and tempo marks.    You can even print all the staves in the score, or just print certain staves.    When you 
check the Print Selected Staves button, a dialog box will appear before printing with check boxes beside 
all sixty four staves.    Only those that are checked will be printed. 

The Character Scaling feature sets the size of the notes on your page.    100 percent is normal.    
If you set it to 200 percent, everything will be twice as big as before.    If you set it to 50 percent everything 
will half as big as normal.    You can use this control to create large scores or miniatures, or you can use it 
to adjust the printed size just a little so that more or less measures might fit on a line.

The Left Right Scaling tells Composer how many grid marks to fit on a line when printing.    When 
the Composer formats a page, it tries to fit as many measures on a line as it can according to the Left 
Right scaling.    If a measure won't completely fit on a line, the Composer doesn't use it and stretches the 
measure that do fit on a line out so that they fit across the whole line.    If you find that you are only getting 
one measure per line, you can decrease the 



Left Right Scaling so that there are more gird marks on a line.    If there are enough grid marks on the line 
a second measure might fit.    In essence, the lower this number, the more measures that Composer is 
likely to be able to fit on a line. The higher this number, the less measure that will fit on a line.

When you press OK, your score will print.

Hints
The Composer uses the distance from the top staff to    the top of the screen as the distance 

between staff groups.    If you have don't have enough space between staff groups when printing, drag all 
of the staves down a little with the right mouse button.

If you don't get as many staff groups on a page as you would like, you can lower the character 
scaling a little so that everything is just a little smaller.    You can also drag the staves closer together with 
the right mouse button.    If an entire staff group can't fit on a page it will be printed on the next page.

If you are getting a lot of lines where only one measure is on a line, reduce the character scaling 
slightly and reduce the Left Right Scaling until you get as many measures per line as you like.    Over use 
of some of the scaling can produce distortion especially with text.

If your text isn't lining up properly, go back to the score an re-enter it so that there is only one 
word in a block.    Also, left right character scaling will scale the text width-wise and it could start looking 
funny. 

The Composer uses the measure width that is on the screen.    If when printing parts, you have a 
whole note in a line you are printing but another line that isn't being printed is full of thirty-second notes in 
the same measure, that measure will get a lot of space on the printed page.    One way to work around 
this is to save the file under a new name and then delete all of the staves you don't want to print.    Then 
go through the measures and use the Delete Unused Grids feature to shrink the measure down and then 
print.    This is more effort than necessary, but you have to admit, its better than copying the parts by 
hand!



About Those Mouse Buttons...

The left mouse button is the one you normally work with. You can highlight a symbol on the 
palette with it, and then click somewhere in your score and place the symbol.    If you click on a symbol on 
the screen and drag it, you can move it to another location, or if you drag it off of the white part of the 
screen you can delete symbols.

The right button selects the staff you are on, switches the location of the blinking cursor, and can 
be used to drag a staff. If you are working with more than one staff on your screen, keep in mind that the 
blue staff is the active, or highlighted, staff.    Anything you do will appear on the blue staff. 

If you want to change the location of Grid marks, you can hold down the Shift key on your 
computer keyboard and then click with the right mouse button and drag a Grid mark.

If you would like to layer staves, you can use the drag option to "stack" one staff on top of 
another.    By changing the name of the staff, you can keep the two different staves layered together, with 
two different melodies. 

We hope that this chapter has been of help to you in learning to make the most of WinSong's 
Composer module.    Once you have spent some time with this program and discovered how it can work 
for you, you will probably never    go back to composing the old fashioned way.



List of Symbols

As you work with Composer, you will notice that many of the options from the pull-down menus 
are also available on the palette push buttons.    The following is a brief discussion of some symbols that 
you will find helpful:

Tuplet Push-buttons

The function button above, which is on the second ribbon of the palette on the main dialog 
screen, allows you to turn the notes that you play into triplets, quintuplets or septuplets.    If for instance, 
you have the Eighth note button and the Triplet button turned on, each note you enter will be an eighth 
note triplet and you will see a little 3 above it.    When you beam the notes together, there will only be one 
3 above the group of notes.

One thing you may want to keep in mind while working is that Composer will not allow whole 
notes to have triplets, quintuplets, or septuplets.

Entering Notes

You can enter notes to the staff by clicking on the push-button function keys with notes on them, 
for example, the ones below:

To use the push-button note features, just click on the note you wish to use, and click on the staff 
in the place where the note should go.    After entering notes, the blinking cursor automatically goes to the 
next location, not to the location of the note you have entered.    Additionally, when you tap the space bar 
at a given note, this will automatically enter a rest of equal value to the staff.

Notes can easily be moved using the Click and Drag technique.    Please remember, however, 
that when a note has been moved its "spelling" and the "spelling" of the chord it is in may be changed.

Marking an Area

When you wish to beam notes together, you will find it convenient to use the Mark button pictured 
below:

You can mark an area with this button activated.    Do this by clicking the button and then 
dragging the cursor over the area you wish to mark.    When you go off the screen to the right or left, the 
staff will automatically scroll in that direction.    When you have marked the notes in a particular area and 
hit Beam, those notes will beam together.



Cut, Copy and Paste Buttons

These are the Cut, Copy and Paste Buttons:

These keys allow you to cut, copy and paste sections of your composition.    If you highlight 
something and use the Copy or Cut buttons, only the highlighted area will be copied or cut.    If nothing is 
highlighted, however, a dialog box will appear asking you to specify where you would like to perform the 
actions.

Accidentals

When you enter one of these symbols onto the staff, it becomes attached to the note it modifies. 
All notes at the same position on the staff in the same measure are changed up to the first one that also 
has an accidental.    When you delete the note, the sharp, flat or natural mark will be deleted as well.

Flip Stems Button

Below is your Flip Stems Button:

Use this button to flip the stems of notes either upside down or right side up.    If the note is part of 
a beamed group, the whole group will be flipped.

Key Signatures/Time Signatures

To place Key or Time Signatures on the staff, click on the appropriate button, make your 
selections in the dialog box, and drag the signature to the measure where it is to be placed.    To get rid of 
a Time Signature, put in a new one that is the same as the previously selected Time Signature.

Volume Buttons

These are your Volume Buttons:

When you put select a Volume symbol, it will automatically change the volume up to the next 



volume mark or the end of the score.    If you select the Crescendo or Diminuendo symbols, they will 
graduate the volume to the next volume mark, if there is one.

Repeats

When you place a Repeat, it tells Composer to repeat all measures up to the End Repeat Mark.    
The repeat symbols are not functional in this version of Composer.

Patch Button

Entering patch changes to your score allows you to change the sounds on your sound card or 
MIDI keyboard while the score is playing.    To use the Patch button, click on it and let go.    A dialog box 
will appear asking you to select a patch number, from 1 to 128.    You must then place the selected patch 
where you wish it to be within the score. To get rid of a patch symbol, drag it off.

Octave Button

Here are the Octave Buttons:

Activate these by clicking on them, and drawing a line above or below the staff where the Octave 
should go.    To get rid of the Octave, click on the Octave Symbol itself, and drag it off of the screen.    If 
you go past the end of the screen while drawing the line, it will automatically scroll to the right.

Trills

A Trill functions much as an Octave does, allowing you to draw a line.      Below is the Trill Button:

Clefs

These are the Clef buttons:

To choose a Clef, click on the appropriate symbol for the Clef you wish to select.    You must then 
place this symbol within the score, by clicking in the proper place on the staff. When you select a Clef, the 



notes will change accordingly    from that point on.

Because the Clef will appear automatically on the Grid mark nearest to where you drop it, if you 
want to change the very first Clef you must    place a Clef on the first Grid mark.
 

Text Button

This is the Text button:

If you would like to add the lyrics to your song, this is how you do it.    Click on this button, and 
type in whatever you wish.    You will continue to enter text until you select another push-button.    To move 
text around on the screen simply click on it and drag it.    It is a better idea to put short, rather than long, 
pieces of text beneath notes so that they will move when the grid changes.

Tie Button

This is your Tie button:

Use this to Tie two notes together that have already been entered to the staff.    To activate this 
function, select the Tie button.    Next, click on the note you wish to Tie from, and then the note you wish 
to Tie it to. 

Remember--the note that you wish to tie to must be located correctly within the Composer grid 
system, and must have the same pitch as the note you are tying from.    For example, if you attempt to tie 
a quarter note to a 16th note, WinSong will not find the note.    And if you attempt to tie a note to another 
note of the same value, but which is not located in the proper place within the grid, the computer will not 
find this either.    You can only tie together two notes of the same pitch which are located the correct 
grid spacing from one another.      (For more information about WinSong's grid system, refer to the 
section of this Chapter which discusses the Options Menu, Show Grid function.)

Finally, if you click on a pre-existing tie, it will flip upside down. Drag the Tie symbol off the note, 
and it will go away.

Pedal    Buttons

Above are the Pedal buttons.    The first button tells the Composer to press the foot pedal on your 
MIDI keyboard while playing.    It will stay down until an end-pedal mark is encountered.



This is the Composer Palette.    There are about 80 symbols to choose from.    The symbol that is 
highlighted is the symbol that will be placed on the screen when you click the left mouse button.    To 
move the symbols just drag click on them again and drag them where you want them.    To delete them 
just drag them off of the white part of the screen. 

To see the other symbols click on the spin button at the far right of the palette.    You can also 
change the palette so that the symbols are arranged in the order you want them to be by using the Edit 
Palette feature under the Options Menu.



These are the Composer edit symbols.    From left to right they are Mark, Cut, Copy and Paste.    
There is also a beam button in the middle.    When you press the Mark button, you can highlight areas on 
the screen that you want to copy or cut or beam.    They only staff that will be affected is the current staff 
which is the blue one.    Once an area is highlighted, press the Cut, Copy or Beam buttons.      If you cut or 
copied an area, you can paste that area at another location within the current file, or to another file in 
another running copy of the Composer, or to the TapeDeck.    A dialog box will appear when pasting that 
asks you where, how many copies, and whether to transpose the pasted copy.

See also the Edit Menu option.



These are the MIDI symbols on the palette.    There is a Play button which looks like a little 
speaker.    There is a MIDI Keyboard On-Off button which looks like a little keyboard, there is a 
Metronome On-Off button which looks like a little metronome.    There is also a MIDI Thru toggle. 

The Play button lets you hear and stop hearing your score.    The MIDI Keyboard button lets you 
tell the Composer to use the MIDI keyboard information it receives for entering in symbols.    The 
Metronome lets you hear a metronome while playing.    And the MIDI Thru buttons toggles whether to 
send incoming MIDI data back out to the MIDI out port of your computer.

See also the Controls Menu option.



In the second line of the palette is the Grid Toggle.    It allows you to see grids on the screen 
letting you know how to line up notes.

There is a red dotted line that goes from the top of the screen to the bottom of the screen.    This 
is a grid mark.    If you put a whole note in a measure, there is only one grid mark.    If you put a half note 
in a measure, there will be 2, if you put a quarter note there will be four.    It is important that you line notes 
up on the correct grid marks or they might sound wrong when you play them back.    All notes up to a 
sixteenth note have red gird marks.    Thirty-second notes, triplets, quintuplets and septuplets have green 
grid marks.    If you want to adjust the position of a grid mark, you can drag the grid by holding down the 
shift key and clicking and dragging with the right mouse button.



These buttons affect the attributes of the notes you are putting in.    If you want your eighth notes 
to be triplets, the toggle the triplet button on.    If you want the note to be dotted or staccatoed then toggle 
those buttons.    When you insert the note, it will have those attributes.    Some attributes are not available 
for certain note values.    A thirty-second note cannot be dotted and a whole note can't be a septuplet, etc.



This is a staff.    The current staff is always blue.    Anything you do such as putting a symbol on 
the screen, cutting, copying or pasting will happen to the current staff.    To change the current staff, click 
on the staff you want to work on with the right mouse button.    You can move staves by dragging them 
with the right mouse button.    You can put them on top of each other if you want to have more than one 
melody line at a time on a single staff.    When printing, the distance from the top staff to the top of the 
screen is the distance between staff groups on the page.    The blinking cursor is the position on the staff 
where notes will pop up when entering them in with the MIDI keyboard.    You can change the blinking 
cursor's location with the arrow keys or the right mouse button.



CHAPTER 3: WINSONG TAPEDECK

WinSong TapeDeck is like a regular tape deck.    You can record onto a track from your MIDI 
keyboard and play it back.    You can also layer tracks by overdubbing and edit the notes you played if you 
made a mistake or just want to change something about your song.    When your recording is all done, 
you can save it and read the file into the Composer and have it written out in standard musical notation.

To get started in TapeDeck, click on the TapeDeck Icon on your Microsoft Windows Screen.    This 
will bring you to TapeDeck's main dialog screen.    If the MIDI driver is not setup properly, a message will 
be displayed at this point.



Getting Started

If you have ever used an ordinary tape player, you should have no trouble using WinSong's 
TapeDeck.    For example, to record, just hit the record button and the TapeDeck will record everything 
you play.    Take some time to familiarize yourself with TapeDeck's Main Dialog Screen by clicking on 
different parts of the screen shown below.



Basic Concepts You Should Know...

Following is a list of things that will help you to understand the use of the TapeDeck better.    
Please browse through them so that you will understand the rest of this chapter better.

TapeDeck Buttons
Counter Window
Track List



TapeDeck Buttons

These push buttons duplicate the options available on the Controls pulldown menu.    They 
function just like those on a regular TapeDeck. (Remember, however, that existing tracks will be played 
while you record unless you Mute those you do not want to hear.)



Counter Window

The Counter will keep track of the Measure, Beat and Tick (ticks are 120th of a quarter note) 
when you use Record or Playback.    If you double click on the counter window, a dialog will appear 
asking you to enter a time to go to.

The push-buttons let you jump to a preset time so you can quickly go back and forth to areas you 
may be working on in your song.      To change the value of each push-button, use the Set Marker option 
on the Goto Menu. 

It is often helpful to turn the metronome on when you are recording so that you can hear the main 
beats.



Track List

There are 64 tracks available to you in WinSong TapeDeck. The main screen displays a list 
containing information about each track, such as the name, number, settings, and number of events in a 
given track.    Anything you record is automatically sent to the track that is highlighted when you are done 
recording.    Any editing you perform will also affect the track that is highlighted.    If you record to a track 
that already has something recorded in it, the new recording will be mixed into the old recording.

Please note that you can double click on a track and an event list showing each individual event 
in the track will appear.    This allows you to examine and change anything about an event that you wish.    
If you press the left mouse over an event it will be highlighted.    You can highlight more than one event by 
holding down the left mouse button and dragging the mouse over a group of events.    If you press the OK 
button you will return to the track list.

If you double click on an event, a dialog box will appear showing you everything about the event. 
You can change anything about an event that you want.

You can edit the MIDI events in a track a whole track at a time, or a single event at a time.    If you 
are currently viewing the track list, a dialog box will appear when using any of the editing commands 
listed under the Edit menu option.    It will ask you a beginning time and an end time for the editing action 
to take place.    Only events that fall within the parameters set in this box will be affected by the edit 
command.    If you have double clicked on a track and are viewing the events in the track, only the 
highlighted events in the event view window will be affected when using the edit functions.

The commands under the Edit menu option permanently change the events in a track.    If you 
want to temporarily change the settings of a track without affecting the events, use the commands under 
the Track menu option.    If for instance a particular track is too loud, you can change the volume on the 
track.    Everything in the track will stay the same but the number you entered in the Track - Volume menu 
option will be added to the volume of each event when you play your song.    If you were to use the Edit - 
Volume command, then the data itself would be permanently changed.



Main Menu Options

WinSong's TapeDeck's pull-down menus include the following:

* File
* Track
* Edit
* Goto
* Controls
* Options
* Help

Some of the features in the pull-down menus are duplicated by buttons on the screen.    There are 
five buttons located below the track list: Open, Save, Save As, New, and Help.    These are exactly the 
same as the menu options with the same names.    The Record, Play, Rewind, Fast Forward and Stop 
buttons at the upper left of the screen duplicate the some of the functions under the Controls Menu.    
There are five Goto buttons below the Counter window. Double clicking on the Counter window will bring 
up the Goto dialog box.    Double clicking on the Heading window above the Track List will bring up the 
track settings dialog box.    Several of the Control menu options have buttons on the screen also.



The File Menu

TapeDeck's File menu is simple and easy to use.    Menu options allow you to:

Open an existing file for playing and editing
Create a new TapeDeck file
Save a file under its current name
Save a file under a new name
Exit the Program

These options are explored in greater detail below:

Open
This is how you open an existing file for playing and editing. You can open files created by 

WinSong's TapeDeck and Composer, as well as standard MIDI files which have been created in another 
program.

The Open dialog defaults to listing files which have the .TDK TapeDeck extension.    To change 
the default, select Composer file (*.CMP) or Std MIDI file (*.MID).

To select a file for opening, either type the complete name in the Name of File field, or use the 
Files, Directories and Type of File lists to locate and select the file you want.

New
Use this option when you want to create a completely new TapeDeck file.    Just select the New 

push-button at the bottom of the main TapeDeck screen, or    the New option from the pull-down File 
Menu.    When you want to save the new file, use the Save or Save As options.

Save
Use this option to save the file you are working on under its current name.    If your file was loaded 

as a standard MIDI file, it will be saved as a standard MIDI file.    It is recommended that you save your 
work as a TapeDeck file unless you are going to export the file to another application.    The TapeDeck 
keeps information that there is no equivalent way to keep in a Standard MIDI file.

Save As
Use this option to save the displayed file under a different name.      Simply type in the complete 

file name, including a drive and directory if necessary, or use the File and Directory lists until the correct 
path is shown.    It is recommended that you save your work as a TapeDeck file unless you are going to 
export the file to another application.    The TapeDeck keeps information that there is no equivalent way to 
keep in a Standard MIDI file.    When saving to Standard MIDI files, muted tracks will be saved with a zero 
master volume event at the beginning.    Some synthesizers do not respond to master volume events and 
may play these tracks anyway.

Exit
This option    allows you to exit the program.



The Track Menu

You can use the Track menu to:

· Name tracks
· Mute tracks
· Automatically repeat tracks (loop)
· Force a track to a MIDI channel
· Change the volume (velocity) of tracks
· Change the overall pitch of tracks
· Erase tracks

These options affect an entire track and are temporary unless you use the Save or Save As 
option.    Remember, you can change selected portions of tracks by using the Edit menu.

Name
Use this to name a Track.    When you select this option, another dialog will be displayed. (The 

Name option can also be brought up by double clicking on the word Name in the Track List window.) Here 
are the choices available under the Name option:

Track Name
Type a name up to 50 characters in length.

Loop
Check this box if you want this track to repeat automatically.

Mute
Check this box if you want this track to be silent.

MIDI Channel
If this is set to 0, then the events on a track will be played on the MIDI channel they came in on.    

If it is 1 - 16, then the events on a track will be forced to that MIDI channel.

Volume
To increase or decrease the volume of this track, enter a value from 64 through +64.    This 

number will be added to the velocity of an event at play time.

Pitch
To increase or decrease the pitch of this track, enter a value from 64 through +64.    This number 

will be added to the pitch of the events in the track at play time. 

When you are satisfied with the displayed information, select OK.    Otherwise, select Cancel at 
any time to return to the Track Menu.

Mute
Mute is    a toggle option.    When you highlight a track and select this option, the track will not be 

played during record and playback (this option can also be found on the main dialog    screen).

Loop
Another toggle setting, Loop tells the highlighted track to repeat automatically.

Force MIDI Channel
MIDI equipment can listen to any MIDI channel.    When you use the Force MIDI Channel option, 



you can force a track to any channel you wish.    Set the channel to any value from 1 through 16.    0 
means no forcing.

Volume
This option allows you to change the volume of the highlighted track. Volume has a range from 64 

through +64.    This number will be added to the key velocity of an event at play time.    A volume of zero 
means that the key velocity of an event will be left alone.

Pitch
                    Select this option to change the pitch of the highlighted track.    Pitch has a range from 64 
through +64.    This number will be added to an event's key number when it is played.    A zero pitch 
means that each note's pitch will remain unchanged.

Erase
Select this option to erase the contents of the highlighted track.    As a safety precaution, a prompt 

will appear asking you to verify the erase.    This is important because Erase is a choice which cannot 
be undone.



Edit Menu

The Edit menu allows you to make detailed changes, either to the track as a whole or to specific 
sections of the track, by physically changing the track data.

You can use the Edit menu to:

· Cut sections from a track.    A section which is cut can be pasted
elsewhere--even into WinSong's Composer.

· Copy sections of a track.
· Paste cut sections into a track.
· Insert a new event into a track
· Quantize (align notes and note endings to the beat)
· Lengthen or shorten note duration
· Change the pitch of all or part of a track.
· Precisely and uniformly adjust the volume of a range of events
· Change the MIDI channel of all or part of a track.

If you are viewing the track list, a dialog box like the one below will appear.    It allows you to 
decide which events are affected by the editing function you are performing.    For instance, if you want 
only notes between the first measure and the second measure and only notes above C3 and below C5 to 
be affected, you can set those parameters here:

The From time tells the TapeDeck what time to begin editing from.    The To time tells TapeDeck 
not to edit notes after that time.    Notice that the Goto Markers are also visible.    You can set the From 



and To time by pressing one of them.
The Which Events box allows you to select what kind of MIDI events to edit.    Lets say you want 

to cut all of the Key Aftertouches from a track but leave everything else.    Set the From time and the To 
time to the beginning and end of the track.    (If you don't know the end of the track, just put something like 
measure 1000 or something.)    Then leave only the Key Aftertouch line checked and press the OK button. 
Only the event types which are checked will be affected.

You may also specify the highest note to be affected, the lowest note to be affect, the highest 
volume to be affected, the lowest volume to be affected, and the MIDI channel to be affected.    If the MIDI 
channel is set to zero, all MIDI channels will be affected.

Normally you will only set the beginning time and end time of the edit.
Please note that if you are viewing the events in a track and not the track list, the dialog box 

shown above will not appear.    Only the events in the track which are highlighted will be affected by the 
edit you are performing.

Cut and Copy
Except for the effect on the track, these functions are exactly alike. You can use Cut to remove a 

section from the track, and select Copy to leave the indicated section untouched. These functions let you 
paste a section of a track into a different part of the same track, into a different track in the same song file, 
or into a completely different song file, or into WinSong Composer.

Paste
Once you have Copied or Cut a section, you can paste it into a different spot on the same track, a 

different track or even a different song file.    To insert the section, simply make sure the correct track is 
active and select the Paste option. 

A dialog will appear asking you the time to paste to, the number of times to paste, and whether to 
align the pastes on measures. 

Insert Event
This option is only available when you are viewing the events in a track.    A dialog box will appear 

that allows you to set the parameters of an event.    If you press the OK button, the event will be inserted 
into the track.    This dialog box is exactly the same as the Edit MIDI Event dialog box.

Quantize
You can use this option to "clean up" and align events which have strayed too far from the beat.    

If you are view the track list, the dialog box shown above will appear.    Once you have pressed the OK 
button a second dialog box will appear asking you the quantize resolution, whether to quantize note 
endings and the number of ticks from the beat to quantize.    If you select quarter note, all notes will 
be moved to the nearest quarter note.    If you check the Quarter note button and the Triplet button, all 
notes will be moved to the nearest quarter note triplet.    If you check the quantize note endings, all notes 
will be moved to the nearest resolution you have selected, and then the length of the note will adjusted to 
the nearest note. 

The Ticks from beat slider allows you to select how far away from the beat notes must be before 
they are quantized.    If you set this slider to 5, then only notes which are more than 5 ticks away from the 
resolution you have selected will be quantized.    This helps keep sequences from feeling too mechanical. 

Force MIDI Channel
Use this to set the MIDI Channel of the range of events you have selected.    The MIDI channel of 

every event in the edit area will be changed to the MIDI channel you select.

Volume
Volume adjusts the Key Velocity if every event in the edit area.    The number you enter will be 

added to the event's key velocity.



Pitch 
This options allows you to transpose the pitch of the events in the current edit area.    The number 

you enter will be added to the event's pitch.

Length
Use this option to precisely and uniformly adjust the duration of the range of events you have 

selected.    You can adjust the length by an absolute number of ticks or by percentage. 
If you select percentage, then the number you enter will make every note's length that percentage 

of its current length.    If the number is 50, then every notes length will be 50 percent of its current length, 
or half as long.    If the number is 200, then every note's length will be doubled or 200 percent of its 
current length.    100 percent will mean no change.

If you select Ticks, then the number you enter will be added to the current length of all the notes. 
Use negative numbers to shorten notes.



Goto Menu

The Goto Menu allows you to:

Goto a place in your song
Goto the time in the 1st through 5th Marker
Set the 1st through 5th Marker

Goto allows you to jump to a time that has not been pre-set.    When you select this option, a 
dialog will appear asking you to enter the time (measure, beat and tick) to go to.      1st-5th Marker lets you 
jump to one of five pre-set times.    Finally, Set 1st through 5th Marker lets you set one or more of the 
Goto times.    Keep in mind that clicking on the Counter window    box is another way of bringing up the 
Goto dialog.

Setting Goto markers is a convenient way to go back and forth between important areas of the 
song you are working on.    If the bridge is at measure 24 and you find you need to start there all the time, 
set a marker for measure 24 and then you can just jump right there.

The markers you set will be saved when you save your song to a file.



Controls Menu

Use the Controls menu to:

· Play the active song file.
· Record to a track.
· Stop Play and Record.
· Rewind to the beginning of the song file.
· Fast Forward the song.
· Step record notes.
· Set the current tempo of a song.

With the exception of Step Record, all of these options are available with the push buttons on the 
main TapeDeck screen.

Play
Select this option to play the active song file. Playing begins at the current time, so you may need 

to use the Fast Forward, Rewind or Goto options to begin at the time you want. Unless muted, all tracks 
will be played.

Record
This option lets you begin recording on the active (highlighted) track at the current time.    Unless 

muted, other tracks will play along as you Record.

Stop
Select this option to stop Playing or Recording.    The escape key also stops the TapeDeck.

Rewind
Use this to reset the song to its beginning.

Fast Forward
Use this to advance forward by a beat.    This is more useful if you press the Fast Forward button 

on the screen.

Step Record
                      This option is very useful if your playing skills are somewhat stiff, or if you wish to 
transcribe sheet music to a TapeDeck file.    You can enter a song one note at a time, but play it back at 
whatever speed you wish.

When you use this option, TapeDeck is listening to your MIDI keyboard and this dialog box will 
appear:



When you press a note or chord on your MIDI keyboard and then let off, the notes will be entered 
into the TapeDeck at the Current Time at the volume level that you played them.    If you stagger the 
notes, none will be entered until you completely let off of the keyboard.    These notes will have the length 
that is currently in the Size of Step in Ticks box.    The current time will then be advanced by the current 
step size.    If you want to leave a space, tape the space bar and the current time will advance by the 
current step size.

You can set the size of the step in ticks.    There are 120 ticks per quarter note.    If you use the 
step size buttons on the screen, the correct number of ticks will for the note length you choose will be 
entered into the Size of Step window. 

When you are done recording, press the OK button and you will return to the main screen.

Tempo
This option allows you to change the tempo of the song you are playing.    Adjust to the desired 

tempo and select OK.    The tempo settings in the Tempo map will be affected.



Options Menu

Use the Options menu to:

· Synchronize the beat to a type of equipment.
· Filter Incoming MIDI events and map MIDI channels to tracks.
· Toggle the MIDI Thru setting.
· Toggle the Metronome setting.
· Edit the Tempo Map.
· Edit the Time Signature Map.

Sync
Use the Sync option to tell the TapeDeck to create its own internal clock, to synchronize itself to 

the incoming MIDI clock, or to synchronize itself to an FSK Tape pulse (only available when using the 
WinSong MPU-401 driver). 

By default, all the WinSong programs use their own internal timing mechanism.    Sometimes it is 
helpful to synchronize WinSong to an external timing pulse.    If you are dumping a sequence from an 
external hardware sequencer, you will need to set one of them to listen to the other.    WinSong is capable 
of listening to a MIDI clock pulse, although its accuracy will lower than the normal 120 ticks per beat.    A 
dialog will appear asking you whether to synchronize WinSong to itself, to the MIDI clock, or to and FSK 
tape pulse. 

Event Filter
Use the Event Filter option to limit the kinds of MIDI events that the TapeDeck will listen to when 

recording.    Just "uncheck" any event types that you do not want to record.    The event filter also allows 
you to map any of the 16 MIDI channels to a particular track.    This is helpful when you are downloading 
sequences from another computer or another sequencer.    When you are done recording, the information 
received on each MIDI channel will be sent to the track of your choice.

MIDI Thru
This option enables and disables the MIDI Thru feature, which sends incoming MIDI information 

to the MIDI out port on your MIDI card.    If you experience looping problems (infinite echoes), turn the 
MIDI Thru setting to OFF.

Metronome
This option toggles the metronome feature. (If you are using the Roland MPU 401 driver, the 

metronome will only work if supported by your MIDI interface card).    With this feature active, the 
metronome will beep according to the Time Signature during Play and Record.

Tempo Map
This option lets you program changes in tempo throughout the song.    For instance, you might 

want to start a song at 100 beats per minute, but change to 120 beats per minute at measure three. The 
measure, beats, ticks and tempo will be    displayed in the list box.    You can add tempo changes, edit 
existing ones, or delete exiting tempo changes.    When you are finished editing, press the OK button.    
You cannot delete the first tempo of a song.

Time Signature Map
Use this option to make time signature changes in your song. You can change from one time 

signature to another within the song.    The list box displays the measure and the time signature.    You can 
add, edit or delete time signatures from the map. 



Help Menu

TapeDeck's Help Menu is easy to use, with just three options to choose from.    Select Index for a 
look at the various features of TapeDeck, and comprehensive information about each available option.    If 
you need more information about using the Help screens, select Using Help from the Help Menu.



Mute Button

Clicking on this button toggles the mute setting of the currently highlighted track.    When the track 
is muted its contents will not be heard while playing or recording.



Metronome

This button toggles the metronome setting in the TapeDeck.    If the metronome is on, a beep will 
sound at every beep while playing and recording.    The first beat of a measure will have a higher pitch 
than all of the others. 

If you are using the WinSong MultiMedia MIDI driver or the WinSong PC Speaker driver, the beep 
will come out of the PC speaker. 

If you are using the WinSong MPU-401 MIDI driver, the beep will come from the Roland 
MPU-401.    Some MPU-401 clones do not support the metronome and you may not hear anything.



Track Heading

This little box contains the titles of the information in the columns below it.    If you double click on 
it, you will go to the Track Settings dialog box.



Tempo

This little box says the current number of beats per minute.    The spin buttons on the side allow 
you to change the tempo of your song.



Midi Thru

Pressing this button toggles the MIDI Thru setting in the TapeDeck.    When MIDI Thru is on, any 
MIDI data coming into the computer will be sent back out the computer's MIDI Out port.    Be careful about 
MIDI loops.    It is not wise to have the MIDI Thru on your computer and your synthesizer on at the same 
time.



CHAPTER 4: WINSONG JUKEBOX

WinSong Jukebox lets you play lists of songs and pauses in any order that you wish.    This can 
be very helpful for live situations where you want to pre-program a set of music, or rehearsal situations 
where you need easy access to a list of songs. 

  



Getting Started

To get started in Jukebox, just click on the Jukebox Icon in Microsoft Windows. This brings you to 
the main dialog screen.    Jukebox will let you play any song on your song list. Initially, however, that Song 
List will be empty.    To build a list, simply use the Open or New options, discussed in detail below.

Many of the options available on the pull-down menus are duplicated by push buttons on the 
screen.    Take some time to familiarize yourself with the screen shown below:



File Menu

Your can use the Jukebox File menu to open a song file, create a list of songs, save files, and exit 
the program.    Listed below are the functions available under the File menu, as well as a brief discussion 
of each:

· Open an existing song list for playing
· Create a new song list file
· Save a file under its current name
· Save a file under a new name
· Exit the program

Open
This option allows you to open an existing file.    You can open files created by the WinSong 

Jukebox, TapeDeck,    Composer, or even standard MIDI files which have been created in another 
program. 

If you open a Jukebox file, you are automatically opening up a list of song files.    If you open 
another type of file, this file will just be added to the end of the current song list.

The default setting shows files which have the .JKB Jukebox extension.    However, if you wish to 
change the default, simply select Composer file (*.CMP), TapeDeck (*.TDK) or Std MIDI file (*.MID).

To open a file, select it by typing the complete name in the Name field, or by using the Files, 
Directories and Type lists to locate and select whichever file you wish.

New
This option allows you to create an entirely new Jukebox file.    To do so, simply click on the New 

push-button at the bottom of the main Jukebox screen, or select the New option on the pulldown File 
menu.    A new screen will appear.    To save your new file, use the Save or Save As options.

Save
Use this option to save your work under its current name.    If the song hasn't been named yet, the 

Save As dialog box discussed below will appear.

Save As
This option lets you save the displayed file under a new name.    Select Save As, and type in the 

complete new name.    Be sure to include a drive and directory if necessary, or use the File and Directory 
lists until the correct path is shown.

Exit
To exit Jukebox, just select Exit from the File menu.



Edit Menu

The Edit Menu offers you the following choices:

· Insert Song at the End of the List
· Insert Song Before Highlighted Song
· Insert Pause at End of List
· Insert Pause Before Highlighted Song
· Delete Highlighted Song

Insert Song at End lets you add a song to the end of the current song list, while Insert Song 
Before lets you place a song directly before    the currently highlighted song or pause.    Insert Pause at 
End lets you place a pause at the end of the current song list, and Insert Pause Before allows you to 
include a pause immediately before the highlighted song or pause.    Delete simply removes the 
highlighted song or pause from your song list.



Controls Menu

The Controls menu offers you the following functions:

· Play
· Stop
· Skip Up
· Skip Down

Following is a brief discussion of each of these features.

Play
You can use this to play your active song list, beginning with the currently highlighted song.

Stop
This option allows you to stop the song that is playing.

Skip Up
The Skip Up function allows you to move back to the previous song.    This option is not available 

while playing.

Skip Down

Use your Skip Down option to move ahead to the next song.    This option is not available while 
playing.



Options Menu

The Options menu allows you to:

Change the tempo of the song being played.
Toggle the metronome on or off.
Toggle the MIDI Thru function.
Change the synchronization setting.

Tempo
When you wish to change the tempo of a song as it plays, choose this option.    Simply adjust to 

the tempo you desire and select OK.    The Tempo setting only affects the song currently being played. 

Metronome
This option turns the metronome on and off.    If activated, the metronome will beep according to 

the time signature.

MIDI Thru
This option enables and disables the MIDI Thru feature, which sends incoming MIDI information 

to the MIDI out port of your MIDI card.

Sync
Use the Sync option to tell the JukeBox to create its own internal clock, to synchronize itself to the 

incoming MIDI clock, or to synchronize itself to an FSK Tape pulse (only available when using the 
WinSong MPU-401 driver). 

By default, all the WinSong programs use their own internal timing mechanism.    Sometimes it is 
helpful to synchronize WinSong to an external timing pulse.    If you are dumping a sequence from an 
external hardware sequencer, you will need to set one of them to listen to the other.    WinSong is capable 
of listening to a MIDI clock pulse, although its accuracy will lower than the normal 120 ticks per beat.    A 
dialog will appear asking you whether to synchronize WinSong to itself, to the MIDI clock, or to and FSK 
tape pulse. 

Pause
This option allows you to insert a pause between songs. The default pause setting is 20 seconds, 

but you can adjust this as you wish.      To change the setting, simply type in a new value or use the spin 
buttons.



Help Menu
If you should have questions about any of the features of WinSong's JukeBox, help is just a menu 

item away!    Simply access the Index selection from your Help Menu, and follow the instructions.    You 
can get as specific as you wish, just by clicking on the features that you wish to learn more about.    
JukeBox users will find the Help screens to be both comprehensive and clearly written.



Chapter 5: WinSong Screen Savers
WinSong can add music to either AfterDark Screen Savers or the Windows Desktop Screen 

Saver.    After the WinSong install program has finished installing the WinSong program files, it will ask 
you if you wish to use the WinSong screen savers.    You may choose either or both the AfterDark and 
Windows Screen savers.

For additional Information, choose:
After Dark Screen Savers
Windows Screen Savers



Adding WinSong Music to After Dark

Before you try to install the WinSong screen saver for AfterDark, you should be sure that 
AfterDark 2.0 is installed and working properly.    WinSong needs for certain AfterDark files to be present 
when installing.    WinSong will not work with versions of AfterDark previous to version 2.

Once you have installed both AfterDark and WinSong, run the AfterDark Control Panel. (WinSong 
will not alter your current AfterDark setup).    You should make sure that the normal AfterDark sound is 
turned off because it will conflict will WinSong.    You can do this by pushing the "Setup" button and then 
the "Sound" button.    Make sure that "Mute Sound" check box is checked.

The list of screen savers will now include several new screen savers.    All of the WinSong screen 
savers will have a name with WinSong as the first word.    Select one of these screen savers and hit the 
demo button to make sure that it works.    If WinSong encounters any errors, a message will be displayed 
at the top of the screen describing the problem.

Using the WinSong controls

There are several screens that come with WinSong.    Some of these are really just MultiModules 
that have been set up ahead of time but include the Module named WinSong.    The WinSong screen 
module really isn't a screen module.    It does nothing to the screen, it merely blanks the screen and plays 
music.    It is designed to be used in conjunction with other screens, including the ones that come with 
AfterDark.

There are several controls with the screens.    The first one is a button called Song Name.    It 
allows you to select a song that will be played with the current MultiModule you have selected.    It will 
remember which songs go with which MultiModules.    When you press this button a file dialog box will 
appear which will allow you to select a song file.    It can be a standard MIDI file, a Composer file, a 
TapeDeck file, or a JukeBox file.    If you choose a JukeBox file, all of the songs mentioned in the file will 
be played one after the other.

The other two buttons allow you to set the pitch and volume the file will be played at.    A setting of 
1 will not alter the MIDI output.

Putting new music to old screen savers

Putting music to a favorite screen saver is easy.    First go to the MultiModule screen in AfterDark 
and create a new MultiModule with the name of your choice.    Save it before you try to include the 
WinSong screen saver with it (otherwise WinSong will think you are trying to put a song to the 
MultiModule screen).    Now edit the new MultiModule and include the WinSong screen as part of it.

Press the Song Name button and select a song to play while the screen appears.    WinSong will 
remember the song that goes to that MultiModule event if you choose a different song for a different 
MultiModule.

You can create your own songs to put to screens in the TapeDeck or the Composer.



Adding Music to Windows Screen Savers

To use WinSong with the Windows screen savers, go to the Windows Control Panel and run the 
Desktop Icon.    In the screen savers section, pull down the list box containing names of screen savers.    
Choose the WinSong Screen Saver.    Press the Setup button and a dialog box will appear asking you 
what song you wish to use and what screen you wish to use.    Set these to song and screen of your 
choice.    When you are finished press the OK button.    Now press the Test button to make sure that 
everything is working.    If the other programs in WinSong are working, the screen saver should work.    If 
you experience difficulties, go through the normal WinSong trouble-shooting procedure.



APPENDIX A: ANSWERS TO COMMON QUESTIONS

Question: I installed WinSong using the Roland MPU-401 driver, but no sound comes out.    How 
come?

Answer: If you are using the Roland MPU-401 driver and it isn't working for you, there are several 
things to check.    First, make sure that the port and IRQ settings that you gave in the WinSong install 
program match the settings on your card.    If the port setting is wrong, you will get a message when 
starting a WinSong program that the port could not be initialized and that no midi functions will work.    If 
the IRQ setting is wrong,    You will get a message that the IRQ could not be hooked.

Another likely problem is that the Windows 3.1 MPU-401 driver has been loaded into memory.    In 
that case, the WinSong driver will not function.    The cure is to remove the Windows driver and restart 
Windows, or use the WinSong MultiMedia driver and process midi through the Midi Mapper.

Another possible problem is that your MIDI keyboard is not connected to the card properly, or is 
not listening to the correct MIDI channel.

Question: I am using the WinSong MultiMedia driver and no sound comes out, what do I do?

Answer: There are two likely problems.    The most likely is that your Windows MultiMedia system 
is not configured properly.    First go to the Control Panel and run the Drivers program.        Make sure that 
your driver is on the list and that it is configured properly.    The Midi Mapper driver that comes with 
Windows 3.1 must also be on that list.    Then run the Midi Mapper program in the Control Panel.    You 
must make sure that the Midi map setup you are using is configured to use your sound card driver.    See 
your Windows manual for a more detailed explanation of the MultiMedia system.

If the drivers are loaded and the Midi Mapper is configured properly, the next most likely problem 
is that you are using a driver that directs the sound to the wrong location.    For instance, many sound 
cards support either MIDI or sounds internal to the card.    It could be that you are using a driver that is 
directing the MIDI output to the MIDI port and you are expecting to here it through the sound card, or vice 
versa.    Make sure that your current Midi Map setup is referencing drivers that are putting out sound to 
the correct place.

Another possible problem is that your MIDI keyboard is not connected to the card properly, or is 
not listening to the correct MIDI channel.

Question: I am using a Sound Blaster ( or compatible ) card, but I want to use its internal sounds 
rather than the MIDI port.    How is that done?

Answer: The Sound Blaster comes with different drivers, one that sends MIDI information to its 
internal sound generators, and one that sends it to the MIDI port.    Be sure the Midi Mapper setup you are 
using is redirecting output to the correct driver.    If you are using the drivers that came with Windows 3.1, 
the Creative Labs Sound Blaster 1.5 driver sends output to the MIDI port, while the AdLib Driver sends it 
to the Sound Blaster's internal sound generators.

Question: I have more than one sound card in my computer and want to use a different one for 
MIDI input than I am using for MIDI output.    How is this done?

Answer: WinSong now hooks all MIDI input devices so it should always work.

Question: How come I can't tie two notes together?

Answer: In order to tie two notes together, they must be the same note, and they must be the right 
distance apart in grid marks, otherwise you will get an error message.    That is to say, if you wish to tie a 
quarter note to the next note, it must be a quarter note away.    Use the Grid feature to see if the notes are 
lined up properly.



Question: I want to have more than one melodic line on a staff at the same time.    What is the best 
way to do this?

Answer: Use two staves and place them on top of one another.    That way changes in one line 
won't reformat the other line.

Question: How can I put pickup notes into my score in the Composer?

Answer: Fill the first measure with rests up until your pickup notes, then put in the pickup notes.    
Then delete the rests.    You can then drag all of the unused grid marks as far left as possible by holding 
the shift key and dragging them with the right mouse button.    When you go to print, there will be no 
unused space before the pickup notes.

Question: When I save my TapeDeck or Composer file as a Standard MIDI file, and then read it in 
again, I seem to have lost my track settings and formatting information.    Why is that?

Answer: It is recommended that you don't save your work in Standard MIDI files unless you are 
exporting that file to another application.    The reason is because Standard MIDI files were not really 
designed to hold settings and formatting information that is specific to a program.    It is a general file 
format and some of the unique features in Composer and TapeDeck will be lost in the translation.

Question: I'm having trouble with text disappearing in the Composer when I scroll the screen and 
when I go to print.    What can I do?

Answer: We recommend that you don't put more than a single measure of text on the screen at a 
time.    This minimizes alignment problems when printing.    Any object in the Composer is displayed when 
the grid mark that it is attached to is displayed.    If the grid mark your text is attached to is scrolled off of 
the left of the screen, it will appear to have disappeared.

Question: How do I transpose a piece of music?

Answer: Transposing music is simple.    Highlight the area of music that you want to transpose and 
cut it out of your score.    If you wish to change the key signature for that area, place the new key 
signature at the beginning of the area.    Then paste the music back into the score.    When the paste 
dialog box pops up, it will ask you the number of half steps you wish to transpose the music.    Enter in the 
correct number of half steps up or down that you wish to transpose the music and then press the OK 
button.

Question: How do I write music for transposing instruments?

Answer: Go ahead and write the music in the Composer the way it should look on paper for the 
instrument you are writing for.    Then call up the Staff Settings dialog box under the Staff pull-down menu. 
It has a control for the number of half steps to transpose the staff while playing.    An example is a 
passage for the Bb Clarinet.    If on paper you want to see a C major scale, write a C major scale on the 
staff in the Composer.    Then in the staff settings dialog box, set the staff transposition to -2 (down a 
whole step).    It will sound correct when playing.

Question:
Answer:



APPENDIX B: PROGRAM ERROR MESSAGES

This chapter is designed to give you an overview of    the error messages which you may 
encounter while working with WinSong software programs.    Although the majority of these messages are 
self-explanatory, some of the may seem a little confusing.    We have included notes by some of those that 
you may have questions about. 

We have listed the messages here in alphabetical order. 

Messages

1. A File by that Name Already Exists, Replace it? 

2. A Problem Has Occurred with the MIDI Port, Unable to Continue (you will probably never get this 
message, but it means that something unheard of has occurred, for example, the cable has been
yanked out of the computer accidentally).
 
3. Another Window is Using the MIDI Device (you will get this message if you attempt to play 
the    TapeDeck while Composer is playing, for example).

4. Can't Find CONTROL.EXE (this will appear when the program cannot find the control panel 
executable file.    You must place this file in your Windows directory when running MIDI Mapper).

5. Can't initialize MIDI device, No MIDI functions will work. (For some reason WinSong can't find the 
MIDI device or it does not respond correctly when the device is initialized).

6. Can't load the fonts necessary for printing (WinSong can't find the font files-- they may need to be 
reinstalled). 

7. Can't open file W3.INI, exiting program (W3.INI is the initialization file.    This is where your 
settings are stored) 

8. Data Entry Error (there has been an error entering information)

9. Either can't find or can't load MMSYSTEM.DLL, No MIDI functions will work (this is the Windows 
MIDI system if you are using the MultiMedia driver--you must place MMSYSTEM.DLL in the Windows 
directory or Windows system directory) 

10. Either can't load MIDI driver, or wrong version, exiting program. The MIDI driver specified in the 
WinSong initialization file,    W3.INI could not be found.

11. Error While Saving File, File Not Saved!    Usually this is because of low disk space.

12. File Error #! (all file errors have numbers so you can identify the number of the file error you have 
encountered)

13. General Printer Failure.

14. MIDI Mapper Problem.    WinSong is using the "%s" Driver instead (when the MIDI Mapper is in 
use or can't be found, WinSong will attempt to use another driver if possible)

15. Miscellaneous Error running CONTROL.EXE. (this will appear when the program cannot find the 
control panel executable file.    You must place this file in your Windows directory when running MIDI 
Mapper).



16. No MIDI Device Detected.

17. No More Songs Can be Added to This Song List (only appears in JukeBox program)

18. Not a Valid File Name.

19. Not enough memory free for the MultiMedia system to work properly.

20. Not Enough Memory to Perform this Action, Aborting...

21. Not enough memory to print.

22. Null Pointer Virtual Memory Error, save work to a new file and restart TapeDeck ( a TapeDeck 
specific message, this means that an internal error has occurred)

23. Out of Disk Space.

24. Read Error in the Clipboard File (only appears when errors occur in cut and paste functions)

25. Seek Error in the Clipboard File (only appears when errors occur in cut and paste functions)

26. The MIDI Mapper is either not installed, or not functioning properly.

27. The MIDI Mapper isn't connected to a valid MIDI input device, no MIDI data will be received.

28. The MIDI Mapper isn't connected to a valid MIDI output device, no MIDI data will be sent.

29. The MultiMedia Output System is in use by another program, no MIDI data will be sent out.

30. The MultiMedia System is in use by another program, no MIDI functions will be available."

31. There are Too Many Hanging Notes to Continue Recording.    There is a 400 note at a time limit.

32. There has been a File Read Error while using a Temporary File.

33. There has been a File Seek Error while using a Temporary File.

34. There has been a File Write Error while using a Temporary File. (This usually happens because 
the hard disk is out of space).

35. There has been an Error Allocating Virtual Memory.

36. There has been an Error Reallocating a Memory Block.

37. There has been an Error while Locking Memory.

38. There is no MultiMedia device available, no MIDI functions will be available.

39. There is no MultiMedia input device available, no MIDI data will come in.

40. There is not enough free memory to play this song.

41. There is Nothing to Play.

42. This Printing function not available in this version of Windows (print functions only work with 
Windows 3.1)



43. This Type of File Not Yet Supported.

44. Too Many Programs Running Timers.    WinSong needs to set a timer but can't.    Close any other 
programs which may be using Windows timers.

45. Unable to obtain a Printer Display Context.

46. Unable to Open a Temporary File necessary for this routine.

47. Unable to Open File
 
48. Unable to Open the Clipboard File.    WinSong stores data that is cut or copied in a disk file 
instead of in memory and was unable to open a file.    Usually because too many files are already open.    
Increase the FILES= parameter in CONFIG.SYS

49. Unknown printing problem.

50. Write Error in the Clipboard File.    This message usually happens when the hard disk is out of 
space.    Either make more space available or mark smaller blocks when cutting or copying.

51. You Can't Do That While Playing!

52. You Must Enter a Number Between %d and %d.

53. There is no note at the correct location to tie to.    This happens when you are trying to tie a note 
and there is no note at the proper location in the score to tie it to.

54. The Midi Driver was unable to hook IRQ %d.    Record and Play will not work.    This only happens 
while using the MPU-401 driver.    There is some sort of conflict preventing WinSong from hooking the 
IRQ that your MPU-401 card is configured for.

55. There is no default printer set, unable to run this routine.    For WinSong Composer to print, you 
must have a default printer set in the Control Panel.

56. Unable to load the printer driver, can't run this routine.    The printer driver you have set for your 
default printer could not be loaded.    Either the driver is not on the disk or the file is corrupted.

57. The TapeDeck can't save Composer files.    Save as a TapeDeck file and read into Composer.    
You will get this message if you have read a Composer file into the TapeDeck and are trying to save a file 
with the .CMP extension.

58. The Composer can't save TapeDeck files.    Save as a Composer file and read into TapeDeck.    
You will get this message if you have read a TapeDeck file into the Composer and are trying to save a file 
with the .TDK extension.



APPENDIX C: COMPOSER PALETTE SYMBOLS

Regular Notes:

WinSong Composer offers you several ways of entering notes.    You can either select a note and 
place it with your mouse, or place them with your MIDI keyboard when the MIDI Keyboard button is 
turned on.    Select a symbol by clicking on the screen, tapping the foot pedal on the MIDI keyboard and 
using the keyboard template, or by using the number keys on your computer keypad.    Below is a listing 
of these number keys and notes to which they correspond:

1 Whole Note
2 Half Note
4 Quarter Note
8 Eighth Note
6 Sixteenth Note
9 Thirty-second Note

Tapping the space bar while one of these notes is highlighted will place a rest of equal value onto 
the screen.

The 3 key toggles the triplet button, the 5 key toggles the quintuplet button, the 7 key toggles the 
septuplet button, the period key toggles the dotted note button and the backslash key toggles the 
staccato button also.

Percussion Notes:

Percussion notes function in an identical manner to the regular notes shown above, however, 
there are no keyboard shortcuts to using them. 

Rests:

These are rest symbols.    Place these on the staff using your mouse, or by tapping the space bar 
while a regular or percussion note is highlighted.

Accidentals:

These symbols affect regular notes and percussion notes.    Place them just to the left of the note 
you wish to modify.    Composer will automatically place them where they will best fit onto the staff.    Once 
they have been placed, they cannot be dragged off the screen.    Instead, you must drag the note itself off. 

Clefs:

 



Place clefs by selecting the appropriate clef button (shown above).    Click and drag the symbol to 
a location within the score.

Octaves:

  

These are your octave buttons.    They automatically shift the pitch of notes they are over one 
octave up or down.    Select them by clicking on them, and then draw a line with the mouse to specify 
exactly where you wish the octave change to occur.

Trills:

The Trill button functions in the same way as the octave buttons.    They produce no MIDI output. 

Dynamic Markings:

 

Use these to change the volume within your score.    When you place one of the Dynamic 
Markers, the volume of the score will be changed until the end of the score itself or until the next Dynamic 
Marker.    When you delete one of these, the dynamics do return to their previous level.    Sforzando has 
no effect on a score.

Crescendos and Diminuendos:

These cause the dynamic levels to graduate from the previous dynamic marker to the next 
dynamic marker.    If there is no dynamic marker after these symbols, they will not cause any change.    
When you delete a crescendo or diminuendo, the dynamics will not return to their previous state.

 Text:

Select this to enter text.    Just click where you want the text to appear, and then begin typing.    To 
end text input, select another symbol on the palette or begin a new text area by click with the left mouse 
button in a different location.

Key Signature:

Select this button, and then click on the staff in the measure where you wish to change the key.    
To delete a key, just drag it off the screen.

Time Signature:



This functions like the Key Signature button, above.    However, to get rid of a time signature, 
simply place another time signature on top of it that is the same as the previous time signature.

Tempo:

Place this where you wish within the score.    It will appear above every staff at the same location. 
To get rid of a Tempo marking, click on it and drag it off the screen.    You cannot get rid of the first Tempo 
marking, you can only change it by moving it or placing another one on top of it.

Patch Numbers:

Place these wherever you wish on the staff.    To get rid of them, drag them off the screen.    These 
send MIDI patch changes out while the score is being played.

Pedal Markings:

Place these where you want.    When you are playing the score, the first button turns on the pedal 
on, while the second button turns the pedal off.

Flip Stems:

This button changes the direction of a note stem.    If the note is part of a chord or beam grouping, 
stems of the entire group will shift.    Click on this button to activate the function, then click on the notes 
you wish to flip.

Repeats:

These symbols tell the musician to repeat certain portions of the score.    The first of these buttons 
tells where the repeated section begins, while the second button tells where it ends.    To get rid of a 
repeat, place another on top of it.    These symbols have no effect on playing in this version of the 
Composer.

Del Segno and Da Capo:

Measure Repeat:



Other Symbols:

These remaining symbols do not affect the sound of the score as it plays.    They are for printing 
purposes only.



APPENDIX D: MUSIC NOTATION

Introduction
Musical notation is a fast, efficient and standardized way of representing music, either on paper 

or on a computer.    Before you use WinSong Composer, you should have a basic understanding of how 
conventional music notation works. 

This chapter will teach you enough about conventional music notation so that you can start using 
Composer to write your own songs.    However, if you plan to use Composer for more advanced 
composition we recommend that you purchase a good book on music.

Notes and Rests
The musical symbols which indicate pitch (how high or low a note is) and duration (length of a 

note) are called notes.    Notes look like this:

The musical pitches of notes are named for the first seven letters of the alphabet: C, D, E, F, G, A, 
and B.    This particular ordering is called a C Major scale.

The shape of the note and the tempo determine the duration of a note. Here are the notes, as 
well as the number of beats it usually takes to play each note:

In addition to notes, musicians frequently use rests.    While a note instructs the musician to play 
music, a rest instructs him not to play music.    Rests fill the gaps between notes.    The shape of a rest 
determines the length of the silence "played" by the performer.    Here are the rests, and the number of 
beats it usually takes to play each rest:

Whole Rest (4 beats)
      Half Rest          (2 beats)

        Quarter Rest (1 beat)
Eighth Rest (2 per beat)

Sixteenth Rest (4 per beat)

Thirty-second Rest (8 per beat)

Staves and Clefs
A note's pitch is determined by its position on a staff (five parallel lines) and the clef on the staff.    

Here are the four clefs that are available in WinSong, Treble, Bass, Alto and Percussion:



Notes are placed on the staff left to right in the order in which they are to be played.    The pitch of 
a note is determined by its vertical position on the staff, with respect to the clef placed at the beginning of 
the staff.    The higher the note on the staff, the higher the pitch of a note.    Different clefs are used so that 
notes can be much higher or lower without being so far away from the staff.

The most commonly used clef is the treble clef.    The treble clef is also called a "G" clef, because 
its center circles around the line indicating a "G" note above middle C.

Another common clef is the bass clef or F clef; so called because the clef circles around the line 
indicating an "F" note.

Finally, there is a third clef which can be moved up and down on the staff to indicate pitch.    This 
clef is commonly used as the alto and tenor clefs, but is also occasionally used as a soprano, 
mezzosoprano, or baritone clef.    This clef centers itself on Middle C, and is thus called a "C" clef.    The 
most common form of this clef is the alto clef, which centers itself on the staff.    Here are some clef 
symbols:

Soprano      Mezzo-        Alto        Tenor      Baritone      Soprano 

Piano music (and music for some other instruments) is written on the Grand Staff, which consists 
of a Treble staff combined with a Bass staff below it. Middle C falls on an invisible line between the two 
staves.    The line for middle C is drawn only when necessary.    Below is a picture of the Grand Staff:

Most music is written using the clef that appropriately describes the range of the instrument 
intended to play it.    For example, tubas, bassoons, basses and cellos generally use the bass clef.    
Clarinets, violins and trumpets use the treble clef, while violas typically use the alto clef.    A full orchestral 
or conductor's score typically has many staves (for all of the instruments) on the score at once; each staff 
will have a clef appropriate for the instrument intended to play that staff.

Leger Lines
Notes sometimes fall above or below the staff, making it difficult to tell what pitch these notes are 

without leger lines. Leger lines are used when notes fall outside of the range of a staff, and to make it 
easier to tell which notes belong to which staff when there are many staves in the song.    The Composer 
automatically puts the leger lines in for you.



Key Signatures
Normally, the clef on a staff is followed by a key signature and a time signature and then by the 

notes of the song.    A song with no key signature is in the key of C major, meaning that it is based on the 
major scale that starts with the "C" note. Occasionally you may wish to write songs in other keys.    You 
must then indicate this "key" in your song.    A group of sharps or flats following the clef is called the key 
signature.    This tells you what scale the music is built upon.

Each key signature can indicate more than one key--normally one major key or one minor key.    
For example, if there are no sharps or flats, the key is either C major or A minor.    To tell what key a piece 
of tonal music is written in, look at the last note of the song.    Usually, the last note of the song will reflect 
the key of the song, although there are always exceptions.

The key signature also lets you know which notes are to be played consistently sharp (raised 1/2 
step) or flat (lowered 1/2 step) throughout the song.    For example, in E flat major (three flats), all B's, E's 
and A's are flatted, unless otherwise indicated in the music.

C Major C Major

A Minor A Minor

G Major F Major

E Minor D Minor

D Major B Flat Major

B Minor G Minor

A Major E Flat Major

      
F Sharp Minor C Minor

E Major A Flat Major

      



C Sharp Minor F Minor

B Major D Flat Major

G Sharp Minor B Flat Minor

The Circle of Fifths
Keys which differ by only one sharp or flat are separated by seven semitones up or down.    For 

example, down from the key of C to the key of G = CBA#AG#G, and (up) to the key of F = CC#DD#EF.    
It is possible to add five semitones over and over again to a base key, and after 12 iterations arrive back 
at the same key: C, G, D, A, E, B, F#, C#, Ab, Eb, Bb, F, C.    This interesting phenomenon can be 
illustrated using the "circle of fifths".

Minor Keys
Each major key has an associated minor key.    For example, the key    of C major has the same 

key signature as the key of A minor. Here is a list of all of the major keys, with the minor key that shares 
the same key signature.

Sharps Flats

C major - A minor C major - A minor

G major - E minor F major - D minor

D major- B minor Bb major - G minor

A major - F# minor Eb major - C minor

E major - C# minor Ab major - F minor

B major - G# minor Db major - Bb minor

F# major - D# minor Gb major - Eb minor

C# major - A# minor Cb major - Ab minor

Accidentals
Occasionally, a note may not be available in the normal scale or key signature of the key you are 

working in.    For example, you may be writing in the key of C major (no sharps or flats in the key 
signature), but want to play an E flat instead of an E, temporarily.    When this situation occurs, you can 
use an accidental.    An accidental is a (temporary) sharp, flat, or natural inserted in front of a note, 
indicating that it is to be played 1/2 step higher or lower.    This pitch change is temporary, and applies to 
all notes of the same pitch that follow that note for the duration of the measure, or until the next accidental 
on the same note.

Time Signatures
Next to the treble clef are two fours, one stacked on top of the other.    This is the time signature, 



which indicates the musical "meter" of the piece.    Most rock and contemporary songs are written in 4/4 
time (count 1234, 1234, etc.), while a waltz would be in 3/4 time (count 123, 123, etc.).    4/4 time is 
sometimes written using a large "C", which means common time.

The bottom number of the time signature tells us the kind of note which represents one beat    in 
this case, a quarter (1/4) note takes up one beat. The top number indicates the number of beats to a 
measure.

This brings us to another musical symbol, the vertical line after four quarter notes which is called 
a measure bar. A measure is a good way of keeping your music organized.    The frequency with which 
measure bars appear depends on the time signature, which usually describes the length of these musical 
"chunks."    In 4/4 time, a measure bar appears every 4 beats or quarter notes; in 2/4 time, every 2 beats.

Dynamic Markings
Here are the common volume indicators that you can place in your music that tell the person 

reading the music how loud to play it:

fff    fortississimo(very, very loud)

ff    fortissimo (very loud)

f    forte (loud)

mf    mezzo forte (moderately loud)

mp    mezzo piano (moderately soft)

p    piano (softly)

pp    pianissimo (very softly)

ppp    pianississimo (very, very softly)

Other volume indications are rarely used, but for future reference, just insert an extra "issi" in the 
pronunciation for every extra letter which appears in the volume.    Thus, "fffff" would be pronounced 
"fortississississimo!" Other, less often used, indications of dynamics include

fz    forzando (strong accent)

sf or sfz    sforzando (forcibly, with sudden emphasis)

There are special markings to note gradual changes in volume, called crescendos and 
diminuendos.    These indicate an increase and decrease in volume, respectively.    Crescendos and 
diminuendos are written as "crescendo" ("cresc." for short) and "diminuendo" ("dim." for short) or can be 
drawn like this:

The composer or transcriber of the music should give some indication of the start and end 



volumes of the crescendo or diminuendo.

Articulation
Notes can be played at different volumes, as you have learned. They may also be played with 

different articulations.    Notes can be played "staccato," that is, with short durations, where each note is 
distinctly separated from the next.    Notes may also be played "legato," that is, with long durations, with 
each note flowing smoothly into the next.    A staccato note will have a dot above or below the note head 
(the small round ball part of the note), and a legato note will have a small horizontal line placed above or 
below the note head.    WinSong Composer comes with a wide variety of articulation symbols you can 
place in your scores.

Tuplets
Most notes relate to each other by factors of two: an eighth note is half as long as a quarter note, 

a sixteenth note is half as long as an eighth note, and so forth.    Sometimes, however, you will need a 
note that is some other fractional length.    Such notes are called "Tuplets".    The most common of these is 
a triplet, which is displayed as three notes beamed together with a little "3".    For example, each note of 
an eighth note triplet is one third as long as a quarter note (thus, an eighth note triplet is played in the 
same time as two normal eighth notes).    Each note of a sixteenth note triplet is one third as long as a 
sixteenth note, and so forth.    In principle any group of notes is a tuplet, so you can also have Quintuplets 
(one fifth as long, and displayed with a little "5"), and Septuplets (one seventh as long and displayed with 
a little "7)."

Repeat Signs and Alternate Endings
Usually a song is not just a long stream of notes, but a series of repeated musical phrases.    In 

order to conserve time, paper and ink, the music publishers of centuries ago developed various symbols 
to indicate repeated sections of music. These symbols are also helpful to those of us who need to 
conserve precious computer memory!

A repeat sign normally falls on a measure boundary, and is depicted as two vertical lines, 
preceded by two small dots in the center of the staff.    One of the two vertical lines is a bit thicker than the 
other, depending on whether it is a begin or an end repeat (see figure).    These instruct the musician to 
"go back to the beginning of this section of music, and play it over again; when you reach this repeat 
marker again, continue."    The beginning of the section is indicated in one of two ways--either an explicit 
start repeat marker (which looks like an end repeat, only backward), or the start of the song if there is no 
explicit start repeat sign.

Indications of Pitch
Sometimes, you may want to indicate that an entire section of music is to be played an octave 

higher or lower than it is written. Usually this will be for a short section of music, just a few measures.    
This enables the performer to read and play the piece more easily, and saves writers from having to write 
innumerable leger lines.

The sign "8va" is used to indicate that the notes are to be played an octave higher than written 
("8va" stands for the Italian word "ottava," meaning "octave"). The section of music is terminated by the 
word "loco," which is Italian for "location" or in our case, "at the written location."

Transposing Instruments
There is one other case in which a musical instrument plays at a different pitch than written.    This 

case involves transposing instruments.
Transposing instruments are known by the note that is sounded when you play what is supposed 

to be a "C" on that instrument.    For example, you can play a "C" on an E flat alto saxophone, and E flat 
actually comes out of the instrument.    On a B flat trumpet, when a "C" is played, a B flat comes out of the 
horn. 

Some families of instruments, such as the saxophones, include members in many different keys. 
Each of these instruments has a timbre or quality which differs from the other members of its family.    To 
make it easier for people who play one of these instruments to play the other instruments in that family, 
the music written for each particular member of the family is transposed. Transposition compensates for 



the difference between the note as it is named on the instrument and the note as it actually sounds.
"C" on a C melody saxophone sounds like a "C", as you might expect.    However, if you play the 

same fingering on a B flat tenor sax, a B flat soprano sax, or a B flat bass sax, "C" will sound like a B flat. 
Likewise, a "C" on an E flat alto sax or an E flat baritone sax will sound like an E flat.    An F alto sax (a 
very rare instrument, indeed!) sounds an "F" when a "C" is played. Thus, if you can play one of the saxes, 
you can theoretically play all of them, because the fingerings are the same on all members of the 
saxophone family.

When a piece of music is written for a transposing instrument, the name of the instrument and its 
key are placed at the beginning of the music, usually just above the clef sign.    WinSong Composer has a 
provision for transposing instruments, and most MIDI instruments have no difficulty in transposing.



APPENDIX E: MIDI BASICS

Introduction

What is MIDI?    MIDI stands for Musical Instrument Digital Interface.    It allows synthesizers, 
computers, and other musical gadgets to communicate--with each other and with your computer.    One of 
the biggest misconceptions about MIDI is that sound is what travels over the MIDI cables.    MIDI is more 
like a player piano than a phone line.    Directions are sent across the line that tell a synthesizer to play 
this key, then let off of this key, then bend the pitch, etc.    No sound is sent across the lines.    Whatever 
sounds a synthesizer listening to MIDI is capable of making is what is going to be played.

Technically, MIDI is both a hardware interface specification and a serial data protocol.    However, 
you don't have to understand anything about the internals of MIDI to use it.    Take a look at the back of 
your synthesizer, and you'll find connectors labeled "MIDI IN", or "MIDI OUT", or "MIDI THRU"    perhaps 
all three.    Some older or cheaper synthesizers have no MIDI capability, and have no MIDI connectors.    
Neither WinSong nor your MIDI interface can work with these.

MIDI Hardware
The MIDI hardware interface consists of little more than an optically isolated serial connection 

running at 31.25 Kilo baud. The MIDI connector jacks are common five pin DIN connectors, the type you 
can find at your local electronics store.    Often, a synthesizer or MIDI interface will come with extra 
cables, or perhaps your music dealer will include some when you purchase your synthesizer.

You are in no danger of being shocked by the voltages that run through a MIDI cable.

MIDI Connections
Most synthesizers have three connections for MIDI--MIDI 

In, MIDI Out, and MIDI Thru.    MIDI Thru may not be present, and some MIDI equipment may not have 
MIDI Out.    Some MIDI devices (for example, a standalone controller keyboard) may have MIDI Out only. 
Each of these variations will be discussed separately.

REMEMBER:

The MIDI In port receives MIDI messages from an external MIDI 
device.

The MIDI Out port sends MIDI messages from the synthesizer or
computer to another MIDI device.

The MIDI Thru port copies the MIDI messages coming in the
MIDI In port.    This allows you to daisychain your MIDI devices
together.

MIDI Messages
Groups of characters are sent over the MIDI cables in small packets known as messages.    MIDI 

messages tell the synthesizer to play notes, adjust internal parameters, change its voice, etc.    MIDI 
messages do not actually contain sounds. 

Status and Data Bytes
Data is sent serially on a MIDI cable, as bytes of information.    MIDI divides these bytes into 

Status bytes and Data bytes. A Status byte is a specific MIDI command and Channel number, while a 
Data byte is the information which follows (and is associated with) a Status Byte.    MIDI distinguishes 
between the two by focusing on the most significant bit in the byte; if it is on (in the range 128 to 255, or 
80 to FF hex), it is a status byte; if it is off (in the range 0 to 127, or 0 to 7F hex) then it is a Data byte. 
Fortunately, you don't really need to understand hex to use MIDI! 



Channels
Most MIDI messages that are intended for a specific synthesizer have a channel associated with 

them; these are called Channel Messages.    A channel is a number between 1 and 16. Synthesizer 
manufacturers represent the channels between 1 and 16, ordinal numbers that map to their binary 
encodings of 0 to 15 by subtracting one.    You can usually set the receive channel of your synthesizer to a 
given channel.    A single MIDI cable can carry messages for up to 16 different synthesizers.    MIDI 
messages which have no channel associated with them and are intended for all synthesizers are called 
System Messages.

Channel Messages

There are five kinds of Channel Messages.    Each of these consists of two or three bytes of 
information--one status byte followed by one or two data bytes.

Note On and Note Off

These are the basic MIDI messages which turn the sounds on and off in a synthesizer.    Each 
message conveys two pieces of information--the pitch of the note, and the volume of the note.

Aftertouch

There are two kinds of Aftertouch messages; polyphonic and monophonic.    Some synthesizers 
are capable of sending messages which indicate how hard the musician is pressing the keys after playing 
one or more notes.    This capability is called Aftertouch, and can be used to change voice parameters 
such as volume or tremolo.    Monophonic aftertouch is pressure information as it applies to the whole 
instrument; polyphonic aftertouch indicates pressure applied to a single key.

Program Change

A Program Change message indicates a patch change in a synthesizer.    This usually happens 
when someone presses a button or buttons on the synthesizer to change voices.    The number of the new 
patch is between 0 and 127.    How the receiving synthesizer interprets a Program Change message is 
completely arbitrary; patch #5 could consist of trumpets on one synthesizer and a drum noise on another. 
The performer should make sure that the synthesizer receiving this message interprets it properly.

Control Change

This message indicates a change in the setting of some control on a synthesizer.    There are a 
variety of controllers, most of which have been standardized.    Here is a partial list of control changes you 
can make:

Modulation Wheel

Breath Controller

Main Volume

Portamento Time

Pitch Bend

Pitch Bend is a special controller which is used frequently in music.    A Pitch Bend message tells 
a synthesizer to bend the pitch of the notes it plays up or down by a given amount. Because each 
synthesizer can internally adjust its own pitch bend range, the amount of change this message produces 



varies between synthesizers.

System Messages

System Messages are those received by all synthesizers, regardless of what channel they have 
instructed to "listen" to.

Timing Clock

This message allows you to synchronize MIDI devices within a MIDI network.    For every beat in 
a MIDI song, 24 timing clocks are sent over the MIDI network.    In this fashion, such synthesizers as drum 
machines are told to accept their synchronization from the MIDIIn port, which will automatically keep time 
with the song being played.

Start, Stop and Continue

These messages tell the receiving synthesizer that the song is starting, stopping or continuing 
from the last stopping point.

Active Sensing

This is a "dummy" message which is sent over the MIDI network at regular intervals.    
Synthesizers which "see" these and other MIDI messages safely assume that the MIDI connections 
between them are still intact.    These messages will disappear if a cable comes loose.    When this 
happens, a synthesizer will typically turn all of its notes off shortly afterwards.    This prevents notes from 
being "stuck" on during a performance.

System Reset

This message tells the receiving synthesizer to reset itself to poweron condition. 

Song Select

This message is intended for sequencers or drum machines which store different songs within 
them.    This message tells these devices to find and load the given song in preparation for play.

Song Position

This message instructs sequencers and drum machines to begin playing at a specific point within 
a song.    A number between 0 and 16,383 represents the distance in 6 MIDIclock increments (or sixteenth 
notes) from the beginning of the song.    Thus, a value of 32 would indicate the second measure 
(assuming 4/4 time).

Tune Request

Tune Request tells all receiving synthesizers to tune themselves.

System Exclusive Messages

System Exclusive messages are specially designed to allow manufacturers of MIDI equipment to 
create their own MIDI messages. Typically, these messages convey information about patches or 
performance data.

MIDI Software



Currently, MIDI software falls into one of the following seven general categories:

Composition software

Recording software 

Performance software

Sequencing software 

Algorithmic Composition 

Educational software

Patch Editors and Librarians

WinSong's Composer is composition software, used mainly by song composers and arrangers.    
This software specializes in the input, display and printing of conventional music notation. 

WinSong's TapeDeck is recording software.    Used mainly by professional musicians, this 
software allows you to record, play back and manipulate MIDI data streams. 

WinSong JukeBox is software designed for performance applications. 

Sometimes confused with recording software, sequencing software allows you to paste smaller 
pieces of music together in various ways to create a song.    This musical "glue" can consist of loops, 
links, etc.    The pieces may also be simple modifications of other phrases.

Algorithmic composition is an exciting field that deals with computer generated music.    Although 
little practical algorithmic software has been designed for microcomputers yet, you can expect to see 
some interesting developments in the next few years.

MIDI software can also be specifically designed to teach musical concepts and skills, with 
educational software.

The final category of software listed, the patch editor, enables your computer to use special MIDI 
messages to manipulate the sounds produced by your synthesizer.

Because you can get more information on a computer display than you can on a synthesizer 
display (which may be little more than a two number readout), it is usually easier to use programs to 
manipulate this sound data than it is to attempt to change the sound directly on the synthesizer.    Patch 
editors exist for most makes of synthesizers.
.

MIDI Connections

 The synthesizer is broken down to a MIDIproducing section (the keyboard) and a MIDI receiving 
section (the sound generator).    Normally, these sections are internally connected.    MIDI data from the 
keyboard is routed to the MIDI Out connector, and is also mixed with MIDI data entering the synthesizer 
before being piped to the sound generator.    In some synthesizers, the user can exercise some control 
over this internal routing.

Sound Generation



The sound generator in a given synthesizer converts MIDI information into noise.    Modern 
synthesizers use many techniques to create sounds.    The following is a sampling of some methods used 
by today's synthesizer manufacturers:

Frequency Modulation (FM) 

Phase Distortion 

Linear Algorithmic (L/A) 

Analog (sometimes called subtractive)

Sampling 

Each technique works well for different things; none is really better than the others for all 
purposes.    A large studio will probably have one or more of each of the major kinds of synthesizers.



APPENDIX F: MIDI MAPPER INFORMATION 

          Although the Windows MIDI Mapper is documented in the Windows 3.1 manual, some further 
explanation may be helpful.    The MIDI Mapper is a Windows program that shows up in the Windows 
Control Panel when it is installed.    As a convenience, WinSong will start the MIDI Mapper for you from 
the Options menu.    Basically there are three kinds of maps in the MIDI Mapper: a Setup, a Patch Map, 
and a Key Map.

          The purpose of a Key Map is to allow you to translate MIDI notes to other MIDI notes.    You can set 
up a Key Map so that whenever a middle C is sent through it, an F above middle C will be sent out of it.    
This is useful for translating drum parts from one drum machine to another.    If the bass drum on one 
machine is MIDI key 40, but on another its MIDI key 55, you can create a key map that has the source 
key as 40 and the destination key as 55 so that you will still get the bass drum on the second drum 
machine without changing your song.

          A Patch Map is similar to a Key Map.    It translates the patches coming in to different patches on the 
way out.    This is useful if you have a MIDI score that expects to find a Piano sound as patch number one 
on your synthesizer but you have synthesizer that has its piano sound as patch number 50.    You can 
create a Patch Map that has the source patch as 1 and the destination patch as 50 to resolve the 
difference.

          A Setup is for mapping MIDI output to a particular MIDI driver.    Lets say you have two cards on your 
MIDI system, a Roland MPU-401 compatible card and a Sound Blaster card.    You can create a setup 
that tells the MIDI Mapper to send everything on MIDI channel 1 to the Roland Card, but sends everything 
on MIDI channel 2 to the Sound Blaster.    The Port name in the Setup refers to the MIDI driver that you 
have selected to send a particular MIDI channel to.    You will notice that there is a little arrow at the side 
of the Port Name box.    If you click on that, a list of available MIDI drivers will appear.    Select the one you 
wish to send MIDI output to.    A common problem that many WinSong users experience is that the current 
MIDI map is sending MIDI data to the wrong driver.    You can also take all of the output of a given MIDI 
channel and send it to another MIDI channel by changing its destination channel.

          Key Maps are only active when selected into a Patch Map and Patch Maps are only active when 
selected into a Setup, and the only setup that is active is the one currently selected into the MIDI Mapper. 
Generally you don't need to use Patch Maps or Key Maps so its okay if your current MIDI Mapper setup 
has no Patch Maps selected.    You can select different Patch Maps for each MIDI channel.    In each of 
those Patch Maps, you can select different Key maps for each key.    As you can see there are a great 
number of possibilities.

          The WinSong MultiMedia driver always tries to use the MIDI Mapper.    If it is being used by another 
program, it will use the first available MIDI driver and a message will be displayed.    If your current Setup 
is not configured correctly, you may not hear anything or you may hear bizarre things.    The MIDI Mapper 
is one of the first things to check in such cases.

          We hope this explanation has helped you to understand the Windows MIDI Mapper instead of 
confusing you more!



Appendix G - The W3.INI File

These are the current settings that can be made to the W3.INI file in the WinSong directory.

[WinSong] 
Currently all settings are under this application name.    This MUST appear on the first line of the 
W3.INI file.

AUTOSHRINK= 
When set to 1, this tells the Composer to automatically shrink measures after cutting to the lowest 
grid in use in the measure.    This is the equivalent to doing the Staff - Delete Unused Grids command 
on all measures in which a cut operation was performed.

DRUMCACHE=
Any number greater than zero tells the WinSong MultiMedia driver to enable drum caching before 
playing.    ALL drum sounds are loaded.    This option can cause a pause when you start playing as 
the sound card loads sounds from disk.

INDEVICE=
The WinSong    MultiMedia driver now hooks all MIDI input devices in Windows.    This setting is 
obsolete and has no effect.

MPUIRQ=
This is only used when using the WinSong MPU-401 driver.    Valid numbers are from 2 through 7.    (2 
will automatically be switched to 9 when necessary).    Invalid numbers may 
crash your computer.

MPUPORT=
This is only used when using the WinSong MPU-401 driver. Only 300, 320, 332, 334, 336, or 330 will 
work and they are interpreted to be hexadecimal.    Any other numbers will 
be defaulted to 33 hex.

MIDIDLL=
This contains the name of the MIDI driver you wish to use in a given session.    Currently 
W3_MULTI.DLL (MultiMedia Driver), W3MPU401.DLL (Direct MPU-401 Driver), and W3_SPEAK.DLL 
(speaker driver) are the only drivers that come with WinSong. 

PATCHCACHE=
If you are using a MIDI card that requires patch caching, this should be set to 1,    otherwise it should 
be zero or not there at all.    This only has an effect when using the MultiMedia Driver.    It can cause a 
pause when you start to play.    Only the patches that are found in the first five hundred events in the 
sequence will be cached in order to avoid searching the entire sequence every time you hit the play 
button.

RUNNINGSTATUS=
Normally unneeded running status bytes are not sent through the MIDI out port when playing, but 
some MIDI drivers that vendors supply for Windows have a bug because they expect a status byte 
with every message.    Therefore WinSong sends out a status byte with every message by default 
when using the MultiMedia Driver.    If you find that you experiencing delays that you believe are 
caused by too much information going out the MIDI port, a setting of 1 will cause the MultiMedia 
driver to eliminate unneeded status bytes.

ULTRASOUND=
If you have an Advanced Gravis UltraSound card, a setting of one or higher will enable Patch 



Caching and Drum Caching.    A Master Volume message will be sent to MIDI channel ten with a 
volume equal to this number.    Valid numbers are 1-127.

These contain the buttons that are used on the ribbon in the Composer.    You really shouldn't tamper 
with these, although you may delete them if you wish to return to the default WinSong ribbons.
Ribbon_1=
Ribbon_2=
Ribbon_3=
Ribbon_4=
Ribbon_5=

These contain the settings for MIDI volumes when placing dynamic markings in your scores.    They 
have no effect on markings already placed.    Valid numbers are from 1 to 127.

PPP=
PP=   
P=
MP=
MF=
F=
FF=
FFF=



APPENDIX H: GLOSSARY

accidental
An accidental is a musical symbol used to raise or lower the pitch of a note by a halfstep.    Accidentals 
can be a sharp, a natural, a flat, a double flat or a double sharp. See List of Composer Symbols.

aftertouch
The amount of pressure applied to a MIDI keyboard.    Not all MIDI keyboards output aftertouch 
information, and some nonkeyboard MIDI devices (i.e., MIDI wind controllers) may output aftertouch 
information indicating, for example, wind pressure.

bass clef
See List of Composer Symbols.
See clef.

bit
Binary Digit.    The smallest unit of computer information, a bit can be either on or off (1 or 0).    A group of 
eight bits is called a byte, and a group of 16 bits is usually called a word.

breath control
An auxiliary controller, usually (but not always) attached to a synthesizer which is held in the mouth and 
typically used to add vibrato or tremolo by blowing through it.

byte
A group of eight bits.    The most commonly referenced unit of data storage in microcomputers, containing 
one character (a letter, number, or punctuation symbol), or the command or data of a MIDI message.

channel
See MIDI channel.

chord
A group of notes played at the same time.

clef
A symbol in conventional music notation that correlates pitch values with the lines of the staff. WinSong's 
Composer can use Treble, Alto, Tenor and Bass clefs.
See List of Composer Symbols.

client area
The main window of an application which is within the application's borders but does not include the title 
bar, menu bar, and scroll bars.

crescendo
A gradual increase in the volume of a range of music.
See List of Composer Symbols.

cursor 
A symbol on the screen that shows the current position of the mouse or the position at which you are 
typing.    In the Composer the mouse cursor takes the shape of the note you are placing once you have 
clicked the mouse and then reverts to the arrow when you release it.    The blinking cursor in the 
Composer show you where notes will pop up if you place them with the MIDI keyboard.

diminuendo
A gradual decrease in the volume of a range of music.



See List of Composer Symbols.

DIN plug
A five pin connector used as the standard MIDI interface plug.

dotted note
A note followed by a dot indicates that the note should be played half as long again as it would be played 
without the dot (increases the length of the note by 1/2).

drum caching
Some sound cards require that the software tell them to load drum sounds onto the card before they are 
available.    This is called Drum Caching.    See Appendix G - The W3.INI    File for more information.

dumb MIDI interface
A dumb MIDI interface is usually one which has no internal microprocessor and is dependent upon the 
host microprocessor to process incoming and outgoing MIDI data directly.    Generally it consists of a 
serial port; but it may also have timing circuitry. 

dynamics
A term which describes a whole range of musical notation indicating how loudly a note is to be played.    
See List of Composer Symbols.

envelope
A graph which describes the amplitude of a note over time. Envelopes can also be used (especially in FM 
synthesis) to describe sound pitch and timbre over time.

filter
The act of stripping MIDI information out of a track.

flat
A musical symbol which looks like a 'b', and indicates that a given note is to be played a halfstep lower 
than normal.
See List of Composer Symbols.

forte (f)
Loud.
See List of Composer Symbols.

fortissimo (ff)
Very loud.
See List of Composer Symbols.

fortississimo (fff)
Very, very loud.
See List of Composer Symbols.

glissando
A run in half steps    between one note and another.

grand staff
A large staff made up of two staves, one over another, connected in the beginning by a brace.    Generally 
used in piano scores, the upper staff usually has a treble clef and the lower staff has a bass clef.    In 
WinSong Composer, the brace only shows when printing.

halfstep
The smallest pitch interval in conventional music.



key signature
A series of sharps and flats following the clef which indicates the key of the song.
See also Composer Key Signatures

leger line
Small lines above or below a staff used as aids to determine the pitch of a note off of the staff.

measure
A section of music bounded by vertical bar lines.    Each measure contains a number of beats indicated by 
the time signature.

menu bar
A line of commands which rests under an applications Title bar. Each command, when selected, usually 
opens a small window under the command which displays a number of subcommands.

message
See MIDI message.

mezzoforte (mf)
moderately loud.
See List of Composer Symbols.

mezzopiano (mp)
moderately soft.
See List of Composer Symbols.

mf
See mezzoforte.
See List of Composer Symbols.

MIDI
Musical Instrument Digital Interface.    A hardware interface specification and serial data protocol designed 
to allow musical devices to communicate with each other.

MIDI channel
A number between 0 and 15 (some instrument manufacturers use 1 through 16) attached to most MIDI 
messages, indicating the intended receiver of the message.    Most synthesizers can be programmed to 
receive on a specific MIDI channel, or any MIDI channel (see omnion).

MIDI clog
A condition in which the maximum speed of a MIDI interface (31.25 Kilo baud) is reached, and there are 
too many MIDI messages to be output at the same time.    This sometimes results in error messages, or a 
noticeable delay in musical events.

MIDI interface
A device which adds MIDI capability to a computer.

MIDI message
A packet of data recognized and sent between MIDI devices which communicates a single musical event.

MIDI sync
A method of keeping one or more MIDI instruments synchronized with a song.    Typical users of MIDI 
sync include computers, drum machines, and tape recorders.

modulation wheel



A common control on synthesizers, usually in the form of a wheel but sometimes in the form of a joystick 
or other controller.    Its function is to add some quality to the sound, such as tremolo or vibrato.

monophonic aftertouch
The overall pressure applied to the keys of a MIDI keyboard after they have been pressed.

monotimbral
A monotimbral synthesizer is one that can play notes using only one kind of sound (see patch) at a time. 
The Yamaha DX7 is a monotimbral synthesizer; while the DX7II is polytimbral.

mouse
A hand held computer input device which rests on the desktop, this is a definite necessity for those using 
Microsoft Windows.

mp
See mezzopiano.
See List of Composer Symbols.

natural
A symbol used to cancel the effect of a previous sharp of flat.
See List of Composer Symbols.

note head
The small round "ball" of a note.

note stem
The "stick" on notes smaller than a whole note.

octave
A musical interval which equals twelve halfsteps up or down from a given note.    Mathematically, an 
octave up is twice the frequency of a given note, and an octave down is half the frequency of a given 
note.
See List of Composer Symbols.

omnion
An indication that a given MIDI device will respond to all 16 MIDI channels.

patch
A specific sound structure as defined by synthesizer wave form parameters.    The term "patch" is an 
anachronism from the days when the "guts" of synthesizers were open to the synthesizer programmer; 
"patch" cords were used to connect various pieces of the synthesizer together to create different sounds. 
Newer synthesizers do not have the unsightly cords and use electronic switches instead; however, the 
term "patch" has stuck.    Also called "program."
See also Composer Patch Changes

patch caching
Some sound cards require that the software tell them to load sounds onto the card before they are 
available.    This is called Patch Caching.    See Appendix G - The W3.INI    File     for more information.

patch editor
Specialized software that allows the creation and/or editing of a synthesizer voice on the computer.

patch librarian
Specialized software that allows the storage and transfer of synthesizer voices and banks of voices on 
the computer.



pianissimo (pp)
Very softly.
See List of Composer Symbols.

pianississimo (ppp)
Very, very softly.
See List of Composer Symbols.

piano (p)
Softly.
See List of Composer Symbols.

pitch bend
The ability to gradually increase or decrease the pitch of a note.

playlist
A list of songs and events queued for play in WinSong JukeBox.

polyphonic
The ability to play more than one note at a time.

polyphonic aftertouch
The pressure applied to each individual key on a synthesizer after it has been pressed.    Often, this 
information is not needed and can be filtered out on recording.

portamento
A smooth slide in pitch between one note and another.    See glissando.

program
See patch.

pulsesperquarternote
Abbreviated PPQN, the resolution of the recording/playback of a song.    Typically, at moderate tempos 
PPQN values above 96 do not create audible differences in music.    All WinSong programs have a 120 
PPQN resolution.

punch 
A TapeDeck feature which allows the automatic recording over a portion of the song.

quantization
A TapeDeck feature which allows the MIDI notes in tracks to be adjusted so that they appear on the beat 
(or subbeat).

quintuplet
A set of five notes played in the same time it would normally take to play two notes of the same length.

rest
A musical symbol which indicates silence of a given length.
See List of Composer Symbols.

running status
The ability of MIDI devices to avoid (re)sending the MIDI status byte when a new message is sent out if 
the last message had the same status.    This feature allows fewer bytes to be transmitted and thus 
reduces the chances of MIDI clog.
See Appendix G - The W3.INI    File     for more information.



score
An entire printed composition.

septuplet
A set of seven notes played in the same time it would normally take to play two notes of the same length.

sequence
A series of timekeyed MIDI events stored for later playback.

sequencer
A device or software that records and plays back MIDI information.

sharp
A symbol used to raise the pitch of a note by a halfstep.
See List of Composer Symbols.

smart MIDI interface
These are MIDI interfaces which have internal microprocessors to relieve the burden of MIDI processing 
from the main CPU.    The IBM Music Feature and the Roland MPU401 are smart interfaces.

SMPTE
Society of Motion Picture and Television Engineers.    Usually used to describe a timing and 
synchronization standard adopted to synchronize video recorders.    There are devices which convert 
SMPTE sync into MIDI sync.

staccato
Detached.

staff
A set of five horizontal lines, used to paint or draw musical symbols to compose music.

status byte
The first byte of any MIDI message, which identifies the type of message.    The seventh bit in all MIDI 
status bytes is one.

staves
The plural of staff.

step time recording
A recording method by which time is not taken into account during the recording process-- the performer 
enters time changes as well.

sustain
An effect which allows notes to remain playing even though the keyboard keys have been released.

synthesizer
An electronic instrument which produces musical tones, usually by accepting input from a keyboard or a 
MIDI port.

system message
A MIDI message sent to ALL MIDI devices in a MIDI network.    These include timing information, system 
exclusive data, song selection, etc.

tempo
The speed of a song, usually expressed in beats per minute.
See also Composer Tempo Marks



tick
A subunit of time representing the smallest resolved time increment.    WinSong has a resolution 120 
"ticks" or pulses per quarter note (see pulsesperquarternote).

tie
An arc drawn between two notes of the same pitch indicating that they are to be played as a single, 
continuous note.
See List of Composer Symbols.

time signature
A set of two numbers which indicate the length of a measure and the type of note that is equal to one beat 
in a measure.
See also Composer Time Signatures

title bar
The topmost bar in a Windows application, holding the title of the application.

track
In WinSong TapeDeck, a special section of memory which contains a sequence of recorded MIDI events 
for playback.

transposition
The act of raising or lowering the pitches of a track or an entire song by a specific interval.

treble clef
See clef.

triplets
A set of three notes played in the same time it would normally take to play two notes of the same length. 
For example, an eighthnote triplet takes up as much time as two eighthnotes.

tuplet
A group of notes, usually beamed, with a number next to the beam indicating how many such notes are to 
be played in a beat or even fraction of a beat.    This is indicated by the type of note in the tuplet (see 
triplet, quintuplet, septuplet).

velocity
In MIDI, the volume of a note.    The term velocity is used because the volume of a note corresponds with 
the velocity in which a key is struck.

whole step
A pitch interval equal to two half steps.



Appendix I - Technical Assistance

Although we have tried to make WinSong as easy to use as possible, there may come a time when you 
have a question.

Softronics maintains a dedicated Customer Service Department which is open weekdays from 8am 
through 5pm Mountain Standard Time.    The Customer Service Department can also be reached on our 
24 Bulletin Board Service, on Compuserve, on Internet and on the Softronics Roundtable on GEnie.

Please have this information on hand when you call and include it in your letter when you write:

A. The release version of your product.    This can be found at the bottom of the About Box which 
comes up when you run any of the WinSong programs.    A typical release version would be 
"3.02.06"

B. The serial number of your product.    This can also be found at the bottom of the About Box.

C. The sound card and MIDI keyboard that you are using.

Our Address is:

Attn: WinSong
Softronics, Inc.
5085 List Drive
Colorado Springs, CO 80919

Customer Service : (719) 593-9550
Office : (719) 593-9540
Sales : (800) 225-8590
Fax : (719) 548-1878

Customer Service BBS : (719) 593-9295 (300 - 14,400 baud, 8 data bits, 1 stop bit, no parity)

On GEnie : The Softronics roundtable is on GEnie page 630.    Type SOFTRONICS from any GEnie 
system menu.

On CompuServe :    Softronics can be reached at CompuServe mail address 75410,163.

On InterNet:    Our InterNet address is softron@cscns.com.



Appendix J: Midi Card Configuration

If you are experiencing difficulties getting WinSong 3.0 to work properly, here are some things to 
check before calling Softronics for support.    Choose help for the driver you chose to install during 
installation.

WinSong MultiMedia Driver
WinSong Roland MPU-401 Driver
WinSong PC Speaker Driver

Other Related Topics:
WinSong W3.INI File



WinSong MultiMedia Driver

Be sure that you have installed the proper midi driver for your card in Windows 3.1.    You can tell 
what midi drivers are installed in Windows by double clicking on the Control Panel Icon.    A window will 
open up with more icons, including one called "Drivers" that has a little keyboard and drums in it.    Double 
Click on the Drivers Icon and a list of the currently installed drivers will pop up.    Make sure the driver for 
your card is on that list.    If it is not, then click the Add button and add the appropriate driver.    Some 
drivers will ask you the port and IRQ settings for your card.    Make sure these match the ones on your 
card (see the instructions for your card for details).    You must also make sure that you have the Midi 
Mapper Driver installed on your system.

Next, you must make sure that the Windows 3.1 Midi Mapper is configured properly.    Close the 
Driver window and double click on the Midi Mapper Icon or use choose the MIDI Mapper menu option in 
one of the WinSong programs.    The window will have the name of the current Midi Mapper setup you are 
using.    Click the Edit button to see what midi device each midi channel is mapped to.    A list of Midi 
channels will pop up.    Make sure the port for each Midi channel has the name of your card in it.    Hit the 
OK button when you are done, then hit the close button in the Midi Mapper window.

This is the main problem that people experience when using the MultiMedia driver.    Many sound 
cards have several sets of hardware built onto the card.    Usually there is sampling hardware, an FM 
synthesizer and MIDI ports built onto the cards.    Usually there is a different driver for each set of 
hardware. Often times people have chosen a driver that sends the MIDI information to the wrong place.    
For instance, most users want to hear their music come out of the sound connectors on the card.    To do 
this, the MIDI Mapper must have a driver that sends its output to the FM synthesizer on the card.    Often 
times people have set the MIDI Mapper up so that it is sending the MIDI information to the External MIDI 
out port of the card.    The solution is to set the MIDI Mapper up so that all ports are using the FM 
synthesizer ports.    Usually the drivers have a name that tells you where they are sending the MIDI 
information.    You might encounter a driver that is called Voyetra OPL-3 FM Driver.    That driver will send 
WinSong's output to the FM synthesizer on the card.    Or it may be called something like EXT. MIDI OUT. 
That driver will send its output to the MIDI port on the card and whatever you have plugged into the MIDI 
port is what will make the sound.

Another problem is that the port or IRQ settings for your card don't match the ones you have set 
up for your MIDI driver, or that you have a port or IRQ conflict with another card on the system.    The 
solution is to get the settings right and get rid of the conflict.

Some sound cards, such as the Advanced Gravis UltraSound card require that you use "Patch 
Caching".    Patch caching tells the card to load the sounds its going to use before play begins.    To turn 
patch caching on, add this line to your W3.INI file which is located in the directory you installed WinSong 
to:

PATCHCACHE=1

If you are using the UltraSound card you can add this line instead:
ULTRASOUND=127

Additional Sound Blaster notes
Many users have a SoundBlaster or compatible card and wish to use its ability to play midi with 

its internal sounds rather than through the midi port.    To do this, make sure that the Ad Lib driver is 
installed in the driver list found when opening the Drivers Icon.    Go to the Midi Mapper and select the Ad 
Lib driver on the midi channels you wish to play using the SoundBlaster's internal voices.    If you wish to 
play through the Midi port, use the Creative Labs driver.



WinSong Roland MPU-401 Driver

Normally we recommend that you use the MultiMedia driver instead of the MPU-401 driver unless 
you have a specific reason for doing so.    These reasons include:

You are using Windows 3.0 and don't have the MultiMedia Extensions.
You want to use the Sync-to-Tape feature of the MPU-401.
You have a slow computer and want to keep processor to time to a minimum.

If you are using the WinSong Roland MPU-401 driver and it isn't working for you, there are 
several things you may want to check.

First, make sure that the Windows Roland MPU-401 driver has not been loaded.    To do this, 
check the drivers list in the control panel.    If its there remove it.

Next, make sure that the port and IRQ settings that you gave in the WinSong install program 
match the settings on your card.    If the port setting is wrong, you will get a message when starting a 
WinSong program that the port could not be initialized and that no midi functions will work.    If the IRQ 
setting is wrong, a message will inform you that the interrupt you selected could not be hooked.

You might get the message that the interrupt could not be hooked for another reason.    
Sometimes Windows does not allow WinSong to hook a particular interrupt but it doesn't tell us so.    In 
that case, we suggest that you change the interrupt setting on your card and in WinSong.    We have 
found that IRQ 7 is the most reliable.    This is one of the many anomalies that programmers writing for 
Windows run into.

If you still can't get it to work, then your last option is to use the MultiMedia driver and install the 
Windows Roland MPU-401 driver in the Control Panel.



WinSong Midi Speaker Driver

Use this driver only if you have no other sound card or MIDI support on your computer.    This 
driver will not work under Windows 3.0 unless it has the MultiMedia extensions.    You should have no 
problems whatsoever as there are no configuration settings for the WinSong Speaker Driver.

The WinSong Speaker Driver only plays one note at a time (this is a limit of the PC Speaker).    If 
there is more than one note, the driver will play the highest note.    The main purpose of this driver is to 
allow people with no MIDI setup to hear their scores.



Cassette

This is a cassette.    It has no real meaning and is only here for looks.    On the other hand, many 
things have no meaning, but does that diminish their beauty?    An argument could also be made that ALL 
things have meaning though.



WinSong Composer is a midi scoring program which allows you to easily create and print 
musical compositions.

                      



Key Signatures

To enter in a new key signature, select the Key Signature Icon in the palette.    Then click inside of 
the measure where you want the key signature to be.    A dialog will appear asking you which key 
signature you want.    Select it and press the OK button.

To delete key signatures, click on the key signature and drag it off of the screen.    To change the 
first key signature on a staff, select the Key Signature Icon on the palette and click in the first measure, or 
change the First Key Signature on Staff control in the Staff Settings dialog box.

When you change key signatures, the notes on the staff will be respelled up to the next key 
signature on the staff and your formatting information will be lost.



Time Signatures

To place a new time signature in your score, select the Time Signature Icon on the palette and 
click on the measure in your score where you want the new time signature to begin.    A dialog box will 
appear asking you to set the size of the beat and the number of beats for the new time signature.    When 
you have selected them, press the OK button.    We recommend that you place a new time signature in a 
measure before anything else has been placed in that measure. 

To delete a time signature, place the previous time signature in the measure where the undesired 
time signature is.    It will disappear.    To change the first time signature of a piece of music, place the time 
signature in the first measure.

When you place a new time signature, all time signatures after that will be removed and the entire 
piece will be reformatted from the measure where you placed the new time signature.



Tempo Marks

To insert tempo marks in the Composer, select the Tempo Icon on the palette and click at the 
position where you want the tempo change to take place.    A dialog will appear that asks you the size of 
the beat and the number of beats per minute.    When you have set these, press the OK button and the 
tempo mark will appear at the position where you have placed it in relation to the current staff.    It will 
appear at the same position on ALL the staves.    When you print however, it will only print above the top 
staff.

To change a tempo, click on the tempo mark on the screen and the dialog will reappear.    To 
delete a tempo drag it off of the screen.    The first tempo cannot be deleted.

You have the option when printing to not print tempos. 



Patch Changes

To insert a patch change in the Composer, select the Patch Icon on the palette and click at the 
location in your score where you want the patch change to occur.    A dialog will appear that asks you what 
patch number you want to place.    There is also a sample button that will allow you to hear the patch 
before you press OK.

To change a patch already in your score, click on the symbol in your score and the dialog will 
reappear.    To delete the patch change, drag it off of the screen.





WinSong TapeDeck is a sequencing program which allows precise control over all musical 
events in a composition.

                      



WinSong JukeBox is a song list program which lets you play a series of Standard MIDI, 
Composer or TapeDeck songs, in any order you want. 

                                    



Song List Window
This is the JukeBox Song List window.    The song name that is highlighted is the one that will play 

when you press the play button.



This is the end printing screen.






